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Introduction 
You might be looking at this book for any number of reasons, including: 

• You love IB’s TWS, and are interested in seeing how using its API can 
enhance your trading. 

• You use another online trading application that doesn’t provide the 
functionality of TWS, and you want to find out more about TWS and its 
API capabilities. 

Or maybe you have a reason of your own. However you traveled this happy path, 
you now hold in your hands a unique and potentially priceless tome of 
information. Well, maybe that’s a tiny bit of an exaggeration. The information in 
this book will, however, show you how to use the trading functionality of IB’s 
Trader Workstation and its API. Keep reading to find out how easy it can be to 
augment and enhance your trading via the TWS API. 
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How to Use this Guide 
Before you get started, you should read this section to learn how this book is 
organized, and see which graphical conventions are used throughout. 

This book is designed as a reference book, not a lesson-by-lesson textbook, so 
feel free to skip around and read what interests you at the time. That being said, 
you’ll see that the Pages chapters in section III are ordered as the pages appear on 
the Excel spreadsheet, but that’s just to make it easier for you (and us!) to follow. 

To get the most of out of this guide, you should have at least basic PC skills as 
well as some basic familiarity with Microsoft Excel. 

Throughout this book, we use the acronym “TWS” in place of “Trader 
Workstation.” So when you see “TWS” anywhere, you’ll know we’re 
talking about Trader Workstation. 

Organization 

We’ve divided this book into five major sections, each of which comprises a 
number of smaller subsections, and each of those have even smaller groupings of 
paragraphs and figures…well, you get the picture. Here’s how we’ve broken 
things down: 

Part I: Introducing the Excel API 

The chapters in this section help you answer those important questions you need 
to ask before you can proceed - questions like: “What can TWS do for me?” and 
“Why would I use an API?” and “If I WERE to use an API, what does the Excel 
platform have to offer me?” and even “What other API choices do I have?”  

If you already know you want to learn about the TWS API, just skip on ahead. 

Part II: Preparing to Use the Excel API 

Section II walks you through the different things you’ll need to do before your 
API application can effectively communicate with TWS. We’ll help you 
configure the TWS, download the API software, get the API sample spreadsheet 
up and running, and hopefully become more comfortable saving and opening 
files.  

Part III: Getting to Know the Excel API Spreadsheet 

If trading really is your cup of tea, you’ll want to know all about this section. 
We’ll examine each page of your new API spreadsheet, and discuss the cool 
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things you can do with all of the “action buttons” that we have thoughtfully 
included to help improve your efficiency. 

Part IV: Creating Your Own API Application 

OK, here we’re leaving the world of the known and venturing into new territory 
(which as everyone knows is actually the most exciting place to be). Now that 
you’re familiar with our stuff and how it works, it’s time to leave the nest and go 
out on your own. This section tells you how to use the API to create an 
application that does what YOU want and introduces a few custom-written 
programs. Of course to protect your million-dollar inspiration, you’ll have to 
implement your ideas on your own. Part V will help by giving you some place to 
turn, just in case you get stuck! 

Part V: Where to Go from Here 

After filling your head with boatfuls of API knowledge, we wouldn’t dream of 
sending you off empty-handed! Part V tells you where to look to keep abreast of 
new API releases (which of course means new features you can incorporate into 
your trading), how to navigate the Interactive Brokers website to find support and 
information, where to find some helpful resources outside the realm of IB support, 
(such as Visual Basic and other programming help), and how to find answers to 
Excel-specific questions.  

Footnotes and References 
1Any symbols displayed are for illustrative purposes only and are not intended to 
portray a recommendation. 
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Part I: Introducing the DDE for Excel API 
The best place to start is by getting an idea of what the Trader Workstation, or 
TWS, is all about. In this section, first we’ll describe the TWS and some of its 
major features. Then we’ll explain how the API can be used to enhance and 
customize your trading environment. Finally, we’ll give you a summary of some 
of the things the DDE for Excel API, (versus our other API platforms), can do for 
you! 

Here’s what you’ll find in this section: 

• Chapter 1 – What is Trader Workstation? 

• Chapter 2 – Why Use an API? 
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Chapter 1 - What is TWS? 
Interactive Brokers’ Trader Workstation, or TWS, is an online trading platform 
that lets you trade and manage orders for all types of financial products (including 
stocks, bonds, options, futures and Forex) on markets all over the world - all from 
a single spreadsheet-like screen.  

 

To get a little bit of a feel for TWS, go to the IB website and try the TWS 
demo application. Its functionality is slightly limited and it only supports a 
small number of symbols, but you’ll definitely get the idea. Once you have 

an approved, funded account you’ll also be able to use the PaperTrader, our 
simulated trading tool, with paper-money funding in the amount of $100,000, 
which you can replenish at any time through TWS Account Management. 

What Can You Do with TWS? 

So, what can you do with TWS? For starters, you can: 

• Send and manage orders for all sorts of products (all from the same 
screen!); 

• Monitor the market through Level II, NYSE Deep Book and IB’s market 
depth; 
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• Keep a close eye on all aspects of your account and executions; 

• Use Technical, Fundamental and Price/Risk analytic tools to spot trends 
and analyze market movement; 

• Completely customize your trading environment through your choice of 
modules, features, tools, fonts and colors, and user-designed workspaces. 

Basically, almost anything you can think of TWS  can do - or will be able to do 
soon. We are continually adding new features, and use the latest technology to 
make things faster, easier and more efficient. As a matter of fact, it was this faith 
in technology’s ability to improve a trader’s success in the markets (held by IB’s 
founder and CEO Thomas Peterffy) that launched this successful endeavor in the 
first place. Since the introduction of TWS in 1995, IB has nurtured this 
relationship between technology and trading almost to the point of obsession! 
And as they say, one person’s obsession is another person’s treasure - at least in 
this case that’s how the saying goes, since TWS is indeed a treasure trove to 
serious traders and investors. 

A Quick Look at TWS 

First is the basic TWS trading window. It’s laid out like a spreadsheet with rows 
and columns. To add tickers to a page, you just click in the Underlying column, 
type in an underlying symbol and hit Enter, and walk through the steps to select a 
product type and define the contract. Voila! You now have a live market data line 
on your trading window. It might be for a stock, option, futures or bond contract. 
You can add as many of these as you want, if you want you can create another 
window, or trading page, and put some more on that page. You can have any and 
all product types on a single page, maybe sorted by exchange, or you can have a 
page for stocks, a page for options, etc. The point is, once you get some market 
data lines on a trading page, you’re ready to send an order.  
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What? An order ticket? Sure, we have an order ticket if that’s what you really 
want. But we thought you might find it easier to simply click on the bid or ask 
price and have us create a complete order line right instantly, right in front of your 
eyes! Look it over, and if it’s what you want click a button to transmit the order. 
You can easily change any of the order parameters, right on the order line. Then 
just click the green Transmit guy to transmit your order! It’s fast and it’s easy, and 
you can even customize this minimal two-click procedure (by creating hotkeys 
and setting order defaults for example) so that you’re creating and transmitting 
orders with just ONE click of the mouse. 

TWS also provides a host of real-time account and execution reporting tools. You 
can go to the Account Window at any time to see your account balance, total 
available funds, net liquidation and equity with loan value and more. You can also 
monitor this data directly from your trading window using the Trader Dashboard, 
a monitoring tool you can configure to display the last price for any contracts, and 
account-related information directly on your trading window. 

So - TWS is an all-inclusive, awesome powerful trading tool. You may be 
wondering, “Where does an API fit in with this?” Read on to discover the answer 
to that question. 
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Chapter 2 - Why Would I Use an API? 
OK! Now that you have a little bit more of a feel for TWS and what it can do, you 
can move on to the amazing API. If you actually read that last chapter, you might 
be thinking to yourself “Why would I want to use an API when TWS seems to do 
everything.” Or you might be thinking “Hm, I wonder if TWS can… fill in the 
blank?” OK, if you’re asking the first question, we’ll explain why you might find 
the API useful, and if you’re asking the second, it’s actually the API that can fill 
in that blank.  

TWS has the capability to do tons of different things, but it does them in a certain 
way, and displays results in a certain way, and it’s pretty likely that our 
development team, as fantastic as they are, hasn’t yet exhausted the number of 
features and way of implementing these features that all of you collectively can 
come up with. So it’s very likely that you, with your unique way of thinking, will 
be or have been inspired by the power of TWS to say something like “Holy moly, 
I can’t believe I can really do all of this with TWS! Now if I could only just …fill 
in the blank…, my life would be complete!” 

That’s where the API comes in. Now, you can …fill in the blank…! It’s going to 
take a little work to get there, but once you see how cool it is to be able to access 
functionality from one application from another, completely unrelated one, you’ll 
be hooked. 

In addition to allowing you pretty much free reign to create new things and piece 
together existing things in new ways, the API is also a great way to automate your 
tasks. You use the API to harness the power behind the TWS - in different ways.  

Here’s an analogy that might help you understand the relationship between TWS 
and the API. Start by imagining TWS as a book (since TWS is constantly being 
enhanced, our analogy imagines a static snapshot of TWS at a specific point in 
time). It’s the reference book you were looking for, filled with interesting and 
useful information, a book with a beginning, middle and end, which follows a 
certain train of logic. You could skip certain chapters, read Chapter 10 first and 
Chapter 2 last, but it’s still a book. Now imagine, in comparison, that the API is 
the word processing program in which the book was created with the text of the 
book right there. This allows you access to everything in the book, and most 
importantly, it lets you continually change and update material, and automate any 
tasks that you’d have to perform manually using just a book, like finding an index 
reference or going to a specific page from the table of contents. 

The API works in conjunction with TWS and with the processing functions that 
run behind TWS, including IB’s SmartRouting, high-speed order transmission 
and execution, support for over 40 orders types, etc. TWS accesses this 
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functionality in a certain way, and you can design your API to take advantage of it 
in other ways.  

An Example 

It’s always easier to understand something when you have a real life example to 
contemplate. Following is a simple situation in which the API could be used to 
create a custom result. 

TWS provides an optional field that shows you your position-specific P&L for the 
day, as either a percentage or an absolute value. Suppose you want to modify your 
position based on your P&L value? At this writing, the only way to do this would 
be to watch the market data line to see if the P&L changed, and then manually 
create and transmit an order if you happened to catch the value at the right point. 
Now, enter the API! You can instruct the API to automatically trigger an order 
with specific parameters (such as limit price and quantity) when the P&L hits a 
certain point. That’s power! (See Chapter 20 for details on how to actually 
implement this feature). 

Another Example 

Another nice benefit of the API is that it gives you the ability to use the data in 
TWS in different ways. TWS provides an extensive Account Information window 
that’s chock-full of everything you’ll ever want to know about your account 
status. The thing is, it’s only displayed in a TWS window, like the one below.  
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But, what if you wanted to do something else with this information, like have it 
reflected in some kind of spreadsheet where you log information for all accounts 
that you own, including your checking account, Interactive Brokers’ account, 
401K, ROIs, etc? Again - enter the API!  

You can instruct the API to get any specific account or execution information and 
put it wherever it belongs in a spreadsheet. The information is linked to TWS, so 
it’s easy to keep the information updated by simply linking to a running version of 
TWS. With a little experimenting and some help from the TWS Users’ Guide, 
you’ll be slinging data like a short-order API chef in no time! 

 

Why Use the DDE for Excel API? 
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IB’s API is supported in multiple programming languages including: Java, C++, 
and Active X, and VBA for Excel. This book focuses specifically on just one, the 
Excel version. Why would you use Excel with the API?  

Here are some of the strongest arguments in support of using the DDE for Excel 
API, at least to start: 

Its interface is familiar and inspires confidence! 

Since this API uses Microsoft Excel as its development environment, most users 
already have at least a basic familiarity with its functionality. You may not know 
exactly how to write Visual Basic for Applications code, but you can see values in 
a cell, and with a little coaching will be able to view the sample code behind the 
stuff we give you and learn from that. 

It comes with a fantastic sample program that can and should be used as a starting 
point for anything else you want to do. 

The Excel sample application provides a series of worksheet pages populated with 
sample data, each geared toward helping you implement some specific action, like 
getting market data, sending orders or viewing execution reports.  

The learning curve is small and the time to development is fast. You’re not going 
to need a programming course before you get started here. If you have some basic 
PC skills and a good idea of what you want to do, you could create and implement 
an API interface in a matter of days. In general, the time it will take you to 
implement your new API is minimal compared to our other API technologies. 

 
In order to use the API, you need to have TWS running, and must include 
your login name on each function page of the Excel spreadsheet. 

There are a few other things you must do before the DDE for Excel API will run. 
The next chapter gets you geared up and ready to go. 
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Part II: Preparing to Use the DDE for 
Excel API 
Although the API provides great flexibility in implementing your automated 
trading ideas, all of its functionality runs through the Trader Workstation. This 
means that you must have a TWS account with IB, and that you must have your 
TWS running in order for the API to work. This section takes you through the 
minor prep work you need to complete, step by step. 

Here’s what you’ll find in this section: 

• Chapter 3 – Enable TWS to Support the API 

• Chapter 4 – Download the API Software 

• Chapter 5 – Using the Sample DDE for Excel API Application 
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Chapter 3 - Enable TWS to Support the API 
If you don’t have an account with IB, you can run a lot of the following tasks 
using the Demo TWS system. It will have some limitations, but you’ll get a feel 
for things. If you have an account, we recommend opening a PaperTrader version, 
which simulates the TWS trading environment, and gives you $100,000 in 
phantom cash to trade with.  

Enable TWS to Support the API 

Enabling TWS to support the API is probably the simplest step you’ll encounter 
in this book. It’s probably more difficult to remember to log into TWS before you 
run the API! 

OK, log into TWS, or click the Live Trader Workstation icon on the bottom of the 
IB homepage, then click the type of demo you want to use. Good! Now look up at 
the top of the trading window, and you’ll see a bunch of menus. You want to click 
on the Configure menu, and then hold your mouse over the API submenu. And 
check the Enable DDE Clients checkbox. You also need to ensure that you have 
Microsoft Excel installed on your computer. If you don’t have it, go to the 
Microsoft website to order it. If you’re using Word or have MS Office installed, 
you probably already have it. 

That’s it for the first step. TWS is now enabled to support the DDE for Excel API. 
The rest isn’t too complicated either, just follow along as we continue our API 
preparations. 
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Chapter 4 - Download the API Software 
Next, you need to download the API software from the IB website. 

Step 1: Download the API software.  

This step takes you out to the IB website at 
http://individuals.interactivebrokers.com/en/p.php?f=programInterface&p=a&ib_
entity=lic. The menus are along the top of the homepage. Hold your mouse 
pointer over the Software menu, and you’ll see a list of submenus. You want to 
scroll down and hold your mouse over the Application Programming submenu.  

 

The API Software page contains three tabs. Click the Proprietary API tab to see a 
table with links to software downloads that are compatible with Windows, MAC 
or Unix platforms. When available, there will also be a Windows Beta version of 
the software. Look across the top of the table and find the OS you need. 

 

http://individuals.interactivebrokers.com/en/p.php?f=programInterface&p=a&ib_entity=lic�
http://individuals.interactivebrokers.com/en/p.php?f=programInterface&p=a&ib_entity=lic�
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Step 2: Install the API software. 

Next, go to the place you saved the file, maybe your desktop, and double-click the 
InstallAX.exe file icon. This starts the installation wizard, a process that displays a 
series of dialog boxes with questions you must answer, to make installing the 
application easier for you.  

 
Remember where the installation wizard installs the application. You’ll 
need this information later when you open the API application in Excel. 

 

 

 

 

 

 

 

 

 

 

 

Once you have completed the installation wizard, the sample application installs, 
and you’re ready to open Excel, connect to TWS, and get started using the sample 
DDE for Excel API application! 
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Chapter 5 – Using the DDE for Excel Sample 
Spreadsheet 
OK, you’ve got all the pieces in place. By the end of this chapter, you’ll actually 
be inside the sample API application, all ready to start receiving market data, 
create and transmit orders, and do lots of other cool stuff. The sample application 
is actually a complete application on its own, and provides everything you need to 
get started and more. As a matter of fact, your best bet is to use this file as the 
starting point in creating your own DDE for Excel API application. We’ll show 
you how to do that after we get you inside. 

This next section shows you where to go to open the sample application and hook 
up the pages to the TWS. Be patient with this prep work. Before you know it, 
you’ll be in Chapter 6, where you’ll finally get to use the spreadsheet pages in the 
DDE for Excel API application.  

Step 1: Log into TWS.  

OK, first let’s get TWS started. Log into your account, or even better, log into 
your PaperTrader account. If you don’t yet have a paper trading account, go to the 
IB website and look at the PaperTrader page under the software menu. The 
PaperTrader account gives you access to everything you can get through your 
regular account, but you use phantom money to trade, instead of your hard-earned 
real money.  

Step 2: Open the application and enable macros. 

Now, use your Windows explorer to find the Excel file. If you didn’t change the 
Save location, you’ll most likely find your application, which is called 
TwsDde.xls, under My Computer in C:/Jts/Exce/Excel. Double-click this file 
icon, and when you see a message about macros, be sure you click the button that 
says Enable Macros. If you don’t enable the macros, the sample application will 
be useless to you!  

Step 3: Connect each page to the TWS. 

The first page you’ll see is the Tickers page. At the top, you’ll see a dark blue 
section header that says Toolbar. This gives you all the action buttons you’ll need 
to use the features on the page. But for now, you need to focus on the next 
section, or the blue header that says “Which Trader Workstation.” This section 
has an editable field titled “User Name.” This important field is the place that will 
connect you to TWS  when you enter the username of the workstation you’re 
running. If you enter the wrong username, or forget to enter anything, you won’t 
get connected and nothing will work!  
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Part III: Getting to Know the DDE for Excel 
Sample Spreadsheet 
By now you should have the “working” version of the Excel sample spreadsheet 
up and running. Now comes the fun part - becoming familiar with all the cool 
features. The sample pages give you lots of functionality without making you 
figure out how to implement it. More importantly, you can look at the underlying 
Visual Basic code to see how it was done, and use some of it to get starting 
implementing new creative features of your own! 

Here’s what you’ll find in this section: 

• Chapter 6 – Introducing the Excel Pages 

• Chapter 7 –The Tickers Page 

• Chapter 8 – The Orders Page 

• Chapter 9 – The Extended Order Attributes Page 

• Chapter 10 – The Conditional Orders Page 

• Chapter 11 – The Open Orders Page 

• Chapter 12 – The Executions and Executions Reporting Pages 

• Chapter 13 – The Account Page 

• Chapter 14 – The Portfolio Page 

• Chapter 15 – The Historical Data Page 

• Chapter 16 – The Market Scanner Page 

• Chapter 17 – The Contract Details and Bond Contract Details Pages 

• Chapter 18 – The Market Depth Page 

• Chapter 19 – The Old Style Executions and Account-Portfolio Pages 
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Chapter 6 - Introducing the Excel Pages 
When you first open the sample spreadsheet, you’ll find that our development 
team has included data on many of the pages to help you better understand how 
they work. You can use or delete the data as you want, and add your own. Here’s 
what you see when you first open the spreadsheet: 

 

You can see examples on the Tickers page of how to create tickers for stocks, 
options, futures, future options, indexes, currency and combination lines. In the 
next chapter, “The Tickers Page,” we’ll show you how to set up your own ticker 
lines and request market data. 
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The Pages 

When you open the spreadsheet, you’ll see a row of tabs along the bottom of the 
worksheet. Each of these tabs opens a page, and each page is dedicated to a 
specific function or subset of functions. Many of the titles are self-explanatory, 
but we’ve summarized them all in the following table. 

DDE for Excel API Spreadsheet Pages 

Page Description 

Tickers Set up ticker lines and create links to real-time market 
data. 

Orders Send, manage, edit and cancel orders. 
Extended Order 
Attributes 

Includes all optional order attributes, such as a good ‘til 
date time in force, hidden and discretionary orders, 
volatility orders and others. Apply them to specific orders 
as a template or use as a default by all orders. 

Conditional Orders Similar to the orders page, but also includes a section for 
conditional statements which allows you to create orders 
that are dependent on something else, such as the 
execution of another order or a change in price. 

Open Orders Subscribe to all open orders, whether you created them via 
the API or the TWS. 

Executions Displays all of your order executions. 
Executions Reporting Specify execution report criteria and display only those 

execution reports that meet your criteria. 
Account Displays all account information in real-time, including 

equity with loan value, available funds, and your current 
portfolio value. 

Portfolio Displays positions for all asset types using an array query 
(or, a subscription!). 

Historical Data Displays historical data for an instrument. 
Market Scanner Scans the desired markets to find instruments that meet 

your criteria and displays the results on a separate page in 
descending order. The data continuously updates in real 
time. 

Contract Details This is sort of a research page where you can request 
information on a specific instrument, like the Contract ID, 
the support order types on specific markets, the minimum 
ticks and the trading class. 

Bond Contract Details Similar to the contract details page, but focuses specifically 
on bond details, like the CUSIP, maturity, interest rate and 
bond ratings. 

Market Depth Displays a list of alternative bids and offers away from the 
inside quote, to help you better gauge market liquidity. 

Old Style Executions This is the old Executions worksheet which requires you to 
click a button one time for each line of data to be returned. 
It has have been left intact to allow those with code 
connecting to these pages to revise it and work off of the 
newer pages without losing functionality. We don’t 
recommend using this page to start new projects! 

Old Style Account-
Portfolio 

This is the old Account-Portfolio worksheet which requires 
you to click a button one time for each line of data to be 
returned. It has have been left intact to allow those with 
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Button Name Description 

3 = WARNING 

4 = INFORMATION 

5 = DETAIL 
Show Errors Jumps to the Error Code field and shows the Last Error. 
Clear All Links Removes all links to the TWS. Use this button to ready your 

spreadsheet for saving to disk. 



  

34  www.interactivebrokers.com 

Chapter 7 - The Tickers Page 

 

The Tickers page happens to be the first page you see when you open the Excel 
sample application. Again, remember that you MUST have TWS running, and 
you must enter your TWS user name in the Which Trader Workstation? area 
before you‘ll be able to get data. 

Define a Ticker 

OK, the Tickers page is designed for two main tasks: first, to define tickers, and 
second, to get market data for those tickers. To get started, we’ll enter a ticker for 
a stock, and then request market data. You can see that the TWS API 
development team has included a bunch of sample rows to show you where to 
enter your information. We’ll create a new blank row. When you select any of 
these rows you need to select from the row number in the far left column. 
Otherwise, you’ll only be selecting a single field and many of the programmed 
actions won’t work. So, let’s select any row by clicking the mouse on one of the 
row numbers, then use your right-click button and select Insert. Voila, you have a 
new blank row! OK, let’s do it!  
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1. First, put your mouse in the Symbol field and enter an underlying symbol, 
for example IBM.1 

2. Tab over to the next column, Type, and enter Stk.  

3. Since you want market data for a stock symbol, you don’t need the next 
four columns (Expiry, Strike, P/C and Multiplier) so tab past them and get 
to the Exchange field. This field defines where the market data comes 
from. For example, enter NYSE.  

The next field, Primary Exchange, is optional, and is used to help to 
identify the product, especially in cases where the same symbol may be 
used on different exchanges with different currencies, and you have used 
Smart as the exchange. 

4. Now tab to the currency field and enter the currency in which the product 
trades (for example, USD for US dollars). This field also helps define the 
correct symbol. 

OK, now you need to…wait a sec. You’re done! You’ve successfully entered a 
ticker line for a stock product. Now, want to get some market data running against 
this ticker? OK, but before you do this, you should know that you can also define 
tickers using the Ticker box, which pops up when you click the Create Ticker 
button. Tab through these fields just as you did on the page row, and click OK to 
put the ticker row on your screen. 

Request Market Data 

Now, on to the market data. This is even easier than creating the ticker. First, 
make sure that you have TWS running, and make sure you have entered the 
appropriate user name in the Which Trader Workstation? User Name field.  

OK, are you ready? Let’s begin. 

1. Click on the row number in the farthest left column to select the entire 
row.  

2. Now, move your mouse up to the top of the page and click the button that 
says Request Market Data.  

That’s it. You should now be seeing a row of market data running across all of the 
black fields that are applicable to the type of product you entered on the line. So 
in this case, you won’t see any data in the Implied vol or Delta fields, or any of 
the other fields that are used for other asset types.  

Want to do it again? Let’s get data for all of the sample tickers included. If you 
click in the first row and then press the Request Market Data button, each line will 
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be filled in, and you will be moved to the next line automatically. Keep clicking 
the button and soon you’ll have data for the whole page. That’s all there is to it!  

Create a Group Combination Strategy 

Now, there’s one other function this page allows. You can mark any of these 
ticker lines as belonging to a group combination strategy.  

Simply select a ticker line and then click the Combo Legs button that sits right in 
front of the Request Market Data button. You’ll get a little dialog box that helps 
you define the characteristics of the leg, such as the ratio of this leg to the rest, the 
side (buy or sell), the exchange, and whether the order will open or close a 
position.  

After you have defined the parameters, click the Add button to see the leg in the 
Combination Legs box. Then click OK to close the box, and the Combo Leg field 
on that ticker row will now be populated to identify the ticker as part of a 
combination order.  

We’ve now covered all of the Tickers page functionality. If you want to review 
the definitions of the remaining common buttons, review the table earlier in this 
chapter. Otherwise, let’s proceed to creating orders from the Orders page! 
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Chapter 8 - The Orders Page 
In TWS you view market data and send orders from the same page, but in the 
DDE for Excel API you have a separate page for Orders. Click the Orders tab on 
the bottom of the spreadsheet, and take a look. 

 

You see a bunch of lines that look very similar to the ticker lines you entered on 
the Tickers page. In fact, they are just like those entries. The difference is that 
with these ticker entries you’ll be submitting orders instead of viewing market 
data. Like most pages in the sample spreadsheet, many of the rows are already 
populated to help you understand how the rows and fields work. You might 
however, prefer to have these rows populated with the same tickers you entered 
on the Tickers page, so that you can monitor prices and submit orders on the 
same symbol from two different pages. 

 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 
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Add Your Tickers to the Orders Page 

To add your tickers from the Tickers page to the Orders page, simply copy and 
paste your ticker lines from one page to another.  

1. On the Tickers page, select a row by clicking the row number in the far 
left column, then right click and choose Copy. The selected row starts 
blinking away likes it’s on a marquee. For example, copy the IBM ticker 
line. 

2. Now, come back to the Orders page, select a blank row by clicking in the 
number field of a blank row, right click and choose Paste.  

Depending on which version of Excel you are using, you can also choose 
Insert Copied Cells to paste the copied ticker row a blank row; this 
command automatically moves the other rows down to make room for the 
new row. 

You’ve just created a new potential order row. You can also enter a new ticker 
symbol manually just as you did on the Tickers page. 

Create an Order 

Now you’ll create an order for the IBM1 stock ticker, which you entered by 
copying and pasting its ticker row onto the Orders page.  

1. First, click your mouse in the Action field (the first of the black fields) on 
the IBM1 ticker line, and enter Buy or Sell.  

2. Tab through the fields, and enter the order Quantity (let’s use 100 for this 
example), the Order Type (we’ll use Limit - you can see a list of valid 
order types in a bulleted list on the next page.  

3. Since it’s a limit order, you need to enter a limit price. Take a look at the 
IBM1 market data and come up with a reasonable limit price. Note the 
Auxiliary Price field. This is only used for certain order types, such as 
relative orders, that need two prices. You don’t need to use it for a basic 
limit order. 
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Order Types 

The order types currently supported through the DDE for Excel API are: 

• Limit (LMT)  

• Market (MKT) 

• Limit if Touched (LIT) 

• Market if Touched (MIT) 

• Market on Close (MOC) 

• Limit on Close (LOC) 

• Pegged to Market (PEGMKT) 

• Relative (REL) 

• Stop (STP) 

• Stop Limit (STPLMT) 

• Trailing Stop (TRAIL) 

• Trailing Stop Limit (TRAILLMT) 

• Volume-Weighted Average Price (VWAP) 

• Volatility orders (VOL) 
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Chapter 9 - The Extended Order Attributes 
Page 
These attributes are completely optional, but you’ll find yourself perusing and 
using at least some of them as you become more comfortable with the IB way of 
trading. Some of these attributes are only applicable to Institutional traders and 
others only to advisors, and these are well marked. If you click the Extended 
Order Attributes tab, you’ll notice that this page looks quite different from all of 
the other pages. It doesn’t look like the normal data page, instead it’s a list with 
the attribute and some notes sandwiching the active Value field, where you enter 
your input to control the attributes.  

 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 
 

 

The Extended Order Attributes page is a template. This means that any values 
you enter in the fields on this page will apply to all orders you transmit UNLESS 
you specify a different attribute value on that order line. Remember the last 
chapter, where you took a look at the second black section of fields labeled 
Extended Order Attributes?. That section of the Orders page lets you set 
attributes at the order level, versus the Extended Order Attributes page, which 
applies attributes at a global level, affecting all orders.  
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Now you’ve seen the Orders page, where you create your basic orders, and the 
lovely Extended Orders Attributes page, where you apply such characteristics as a 
new time in force, a display size to create an iceberg order, a discretionary amount 
to give more leeway to your limit orders, and even a checkbox to hide your entire 
order. You can do a lot of cool things with these two pages, but the one thing you 
can’t do is set up conditional orders, which are described in the next chapter. 
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Chapter 10: The Conditional Orders Page 
A conditional order is one that relies on something else happening, either a price 
changing or another order executing, before this order is submitted. Let’s take a 
look at this useful and outstanding order. 

 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 
 

In a nutshell, a conditional order is one that waits around, all set to go, for 
something precipitous to happen that will trigger its coming to life. For example, 
you might want to submit a sell order for 100 shares of XYZ, but you only want 
to do it if you’re first able to buy 100 shares of LMNOP at some specific price. 
With the conditional order all set waiting in the wings, you don’t need to sit 
around watching and waiting to see if the first order executes. All you need to do 
is set up a trigger condition and let it go.  

Take a look at the paired set of sample orders that are included on the 
Conditional Orders page in the sample spreadsheet. 

 

 
The key field in a conditional order is field Y11, the Statement trigger field. Until 
some condition is met, the value in this field is always FALSE. This means 
nothing will happen. When your condition is met, this value becomes TRUE and 
that triggers your conditional order. 

In the above illustration, note the value “FALSE” which appears in cell Y11, the 
trigger Statement field. When you put your curser in this cell, the cell’s condition 
trigger displays on the formula line. In this case the condition says 
“=(M10=T10),” which in English means “the value in this field will be TRUE 
when the value in cell M10 is equal to the value in cell T10.” Let’s look closer 
and see what M10 and T10 really are. You see that cell M10 is the Quantity field 
for the first order, and has a value of 10. Cell T10 is the Filled field for that order 
and currently has no value. Since the filled field shows the filled order quantity, 
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page, and that would not help you one bit. So in this case, to avoid confusion you 
have to use the actual field code. 

4. Again, move your cursor to some other field, and now you’ll see that the 
value in the Statement field is “FALSE,” which is just what you want! If 
the IBM1 bid price drops below 81.00, this will become TRUE, and when 
the Statement value is true - it triggers the conditional order!  

5. Next, you need to tell the API what you want it to do if the bid price drops 
below 81.00. So, in the ADD/MOD field, enter ADD (since you’re not 
modifying an order), then BUY in the Action field, 500 in the Quantity 
field, LMT in the Order Type field and 80.90 in the Lmt Price field.  

OK, you’ve done it. Will this execute for you? Who knows? But if your 
conditions are ever met, your new order will be submitted, that you can count on! 
You can do lots of interesting things with the Conditional Orders feature. We 
recommend you log into your PaperTrader account and experiment. 
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Chapter 11 – The Open Orders Page 
The Open Orders page shows you all transmitted orders, including those that 
have been accepted by the IB system, and those that are working at an exchange.. 
Once you have subscribed, the page is updated each time you submit a new order, 
either through the API or in TWS.  

 
 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 
 

How Do I Subscribe? 

Another way to say this would be “View your open orders.” You don’t subscribe 
in the everyday sense of signing up, paying a fee and receiving something. You 
simply click a button, and the VBA macros working behind the scenes quickly do 
all the complicated stuff, so that you can see all of your open orders. In addition, 
these macros ensure that this data updates in real-time, so that if an order executes 
you’ll know it. 

To do this, imply click the Subscribe to Open Orders button on the toolbar. All of 
your orders will display in the Excel worksheet as soon as they are accepted. If 
you don’t currently have any working orders, the API will kindly tell you that you 
have “None at this time.”  

Even when you log out of TWS or close down your Excel spreadsheet, your 
subscription remains active until you elect to cancel it by clicking the Cancel 
Open Orders Subscription button. If you entered new orders via TWS while the 
API was shut down, as soon as you log back in any new open orders are 
displayed. 

Clearing Open Orders 

To clear the spreadsheet of all displayed open orders, first cancel the subscription, 
and then click the Clear Open Orders button.  
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Named Ranges for Results 

The results are displayed in a “named range” so that they can easily be 
manipulated through a page-specific Worksheet_Calculate macro, which our API 
developers have written and included. A named range is a Microsoft Excel feature 
that lets you assign a meaningful name to a single cell or a range of cells. In the 
DDE for Excel API VB code, we use named ranges on every page to represent 
ranges of cells on that page. For example, on the Open Orders page, we assigned 
the named range “openSubOrders” to all of the cells in the Order Description 
portion of the Open Order results to easily reference those cells in the code. 
 

In Microsoft Excel 2007, you access the named range feature on the 
Formulas tab (for example, the Name Manager displays all names defined 
for the current worksheet). In previous versions of Microsoft Excel, you 
define name ranges from the Insert menu. 

 

Using named ranges, you can tell the API to put the open orders somewhere else, 
like on a different spreadsheet or in a different set of rows and columns. 

View the VB Code 

To view or use the code in this macro: 

1. Use the Excel Tools menu, mouse over the Macro subcommand and then 
choose Macros.  

If you are using Excel 2007, select the View tab at the top of the screen, 
then click Macros button. 

2. Scroll down the code window to find the Worksheet_Calculate macro 
specific to the page functionality you’re interested in. For example, 
Sheet10 macros apply to the Open Orders page, which you can infer by 
the Sheet10 macro names, including subscribeToOpenOrders and 
cancelOpenOrderSubscription.  

3. To see the named ranges used on this page, open the code for Sheet 10 and 
look at the code for the macros used on this page.  

In Excel 2007, you can view all of the named ranges used in the entire API 
spreadsheet by clicking the Formulas tab, then clicking Name Manager. 
In previous versions of Excel, you can view and define named ranges by 
clicking Name > Define on the Insert menu. There is also a Name 
Manager for Excel utility available from Microsoft for versions of Excel 
prior to Excel 2007. 
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What Happens If an Open Order Executes? 

Once an order executes, it remains on the Open Orders page for 30 seconds, with 
the Status value changed to FILLED. Then the filled order is cleared away, and 
you can see it on the Executions page (once you subscribe to real-time 
executions, of course!). 
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Chapter 12 – The Executions Page 
The Executions page is pretty straightforward - it displays the current day’s 
executions.  

 

 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 
 

How Do I Subscribe to Executions?  

Another way to say this would be “View your executions.” You don’t actually 
“subscribe” to anything in the usual sense of signing up, paying a fee and 
receiving something. You simply click the Subscribe to Executions button, and 
the VBA macros working in the background quickly do all the complicated stuff 
and magically populate the screen with your current day’s executions. Your 
“subscription” remains active until you elect to cancel it by clicking the Cancel 
Executions Subscription button. And, any orders that execute while the TWS is 
shut down or the API is logged off will display as soon as you log back and go to 
the Executions page. 

OK, to do all this stuff, simply click the Subscribe to Executions button on the 
toolbar. All of the day’s executions will display in the Excel worksheet. If you 
currently do not have any execution reports, the API will kindly tell you that you 
have “None at this time.”  

Clearing Executions 

To clear the spreadsheet of all displayed executions, first cancel the subscription, 
and then click the Clear Executions button.  
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Named Ranges for Results 

The results are displayed in a “named range” so that they can easily be 
manipulated through a page-specific Worksheet_Calculate macro, which our API 
developers have written and included. A named range is a Microsoft Excel feature 
that lets you assign a meaningful name to a single cell or a range of cells. In the 
DDE for Excel API VB code, we use named ranges on every page to represent 
ranges of cells on that page. For example, on the Executions page, we assigned 
the named range “execSubDetails” to all of the cells in the Execution Description 
portion of the Executions page results to easily reference those cells in the code. 
 

In Microsoft Excel 2007, you access the named range feature on the 
Formulas tab (for example, the Name Manager displays all names defined 
for the current worksheet). In previous versions of Microsoft Excel, you 
define name ranges from the Insert menu. 

 

Using named ranges, you can tell the API to put this execution data somewhere 
else, like on a different spreadsheet or in a different set of rows and columns. 

View the VB Code 

To view or use the code in this macro: 

1. Use the Excel Tools menu, mouse over the Macro subcommand and then 
choose Macros.  

If you are using Excel 2007, select the View tab at the top of the screen, 
then click Macros button. 

2. Scroll down the code window to find the Worksheet_Calculate macro 
specific to the page functionality you’re interested in. For example, 
Sheet11 macros apply to the Executions page, which you can infer by the 
Sheet11 macro names, including subscribeToExecutions and 
clearExecutions.  

3. To see the named ranges used on this page, open the code for Sheet 11 and 
look at the code for the macros used on this page.  

In Excel 2007, you can view all of the named ranges used in the entire API 
spreadsheet by clicking the Formulas tab, then clicking Name Manager. 
In previous versions of Excel, you can view and define named ranges by 
clicking Name > Define on the Insert menu. There is also a Name 
Manager for Excel utility available from Microsoft for versions of Excel 
prior to Excel 2007. 
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The Executions Reporting Page 

In addition to viewing all executions, you can filter your returns using the 
Executions Reporting page. This page is linked to the Executions page (which 
means you don’t need to enter your username anywhere) and can be used as long 
as you have subscribed to the executions function on the Executions page. 
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Chapter 13 – The Account Page 
The Account page shows you everything you will ever need to know about the 
status of your account. Once you’ve entered your TWS Username, simply click 
the Subscribe to Account Updates button and the Account Values section will be 
filled with up-to-the-minute values, from your Equity with Loan Value through 
your margin and P&L values. (see Appendix B for details on all of the values 
shown on the Account page). These values are updated every 3 minutes.  

 
 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 
 

How Do I Subscribe to Account Updates?  

As with the Open Orders and Executions pages, it might have made more sense 
to describe this as “View your account information” rather than “Subscribe to 
Account Updates.” You don’t actually “subscribe” to anything in the usual sense 
of signing up, paying a fee and receiving something. You simply click a button, 
and the VBA macros working in the background quickly do all the complicated 
stuff and magically populate the screen with your up-to-date account information. 
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Your “subscription” remains active until you elect to cancel it by clicking the 
Cancel Account Subscription  button. Note the little field between the buttons and 
the spreadsheet titled “Last Update Time.” This time tells you when the API last 
updated the values on the spreadsheet through TWS. These values are checked 
and updated automatically every three minutes. 

To make this work, simply click the Subscribe to Account Updates button on the 
toolbar. Your latest account information instantly populates the page.  

Clearing Account Values 

To clear the spreadsheet of all the account values, first cancel the subscription, 
and then click the Clear Account Data button.  

Named Ranges for Results 

The results are displayed in a “named range” so that they can easily be 
manipulated through a page-specific Worksheet_Calculate macro, (for the 
Account and Portfolio pages, the macros are for Sheet.14 and Sheet.15 
respectively) which our API developers have written and included. A named 
range is a Microsoft Excel feature that lets you assign a meaningful name to a 
single cell or a range of cells. In the DDE for Excel API VB code, we use named 
ranges on every page to represent ranges of cells on that page. For example, on 
the Account page, we assigned the named range “acctsDataRange1” to all of the 
cells in the Symbol column to easily reference those cells in the code. 
 

In Microsoft Excel 2007, you access the named range feature on the 
Formulas tab (for example, the Name Manager displays all names defined 
for the current worksheet). In previous versions of Microsoft Excel, you 
define name ranges from the Insert menu. 

 

Using named ranges, you can tell the API to put this execution data somewhere 
else, like on a different spreadsheet or in a different set of rows and columns. 

View the VB Code 

To view or use the code in this macro: 

1. Use the Excel Tools menu, mouse over the Macro subcommand and then 
choose Macros.  

If you are using Excel 2007, select the View tab at the top of the screen, 
then click Macros button. 



  

www.interactivebrokers.com  55 

2. Scroll down the list to find the Worksheet_Calculate macro specific to the 
page functionality you’re interested in. For example, Sheet14 macros 
apply to the Account page, which you can infer by the Sheet14 macro 
names, such as subscribeToAccts and requestManagedAccts. 

3. To see the named ranges used on this page, open the code for Sheet 11 and 
look at the code for the macros used on this page.  

In Excel 2007, you can view all of the named ranges used in the entire API 
spreadsheet by clicking the Formulas tab, then clicking Name Manager. 
In previous versions of Excel, you can view and define named ranges by 
clicking Name > Define on the Insert menu. There is also a Name 
Manager for Excel utility available from Microsoft for versions of Excel 
prior to Excel 2007. 
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Chapter 14 – The Portfolio Page 
The Portfolio page displays all of your current positions.  

 

 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 
 

To view your portfolio, simply click the Subscribe to Portfolio Updates button to 
populate the page with the current positions you hold in your portfolio. This page 
works the same as the Account page, and also goes out to TWS and updates the 
values every three minutes, which you can see in the Last Update Time field in 
the Which Trader Workstation area.  
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Chapter 15 – The Historical Data Page 
Use the Historical Data tab to request historical data for an instrument based on 
data you enter in a query. This information equates to charting a contract in TWS 
, except that the information you see is all in rows on a spreadsheet, rather than in 
a pretty colored line or bar chart! As a matter of fact, each row value in the 
spreadsheet is considered a “bar” just a like a bar in your chart. You can request 
historical data as far back as a year, and also for expired futures contracts. 

 

 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 

Excel shows the results on a separate page, which it creates specifically for these 
results. When you define the parameters, you’ll include a name for your historical 
data returns in the Page Name field. 

Note that since the query returns a named range of cells, you can write VBA 
macros to perform computations on it, and you can chart and sort the data in 
Excel. 
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How Do I Request Historical Data?  

Requesting historical data is as easy as pushing a button! Well, first you need to 
make sure you’re hooked up to TWS through your user name, and then you have 
to figure out which symbol you want to request data for. After you’ve done all 
THAT, well THEN it’s just as easy as pushing a button! 

The Historical Data page in the sample application comes pre-populated with all 
types of instruments as examples for you to follow when creating a ticker and 
then requesting historical data. To create a ticker line, it’s the same simple process 
you used to add tickers on the Tickers page. You can either click the Create 
Ticker button and enter the description in the Ticker dialog box, or you can click 
your mouse in an empty Symbol field on the worksheet page and tab through the 
fields necessary to define your ticker. 

Historical Data Parameters 

Now that you have the ticker on the page, you need to define the parameters the 
application will use to find your data. The table below describes the fields that 
appear in the Query Specification section of the Historical Data page. 

Parameter 
Name 

Description 

End Data/Time Use the format yyyymmdd {space}hh:mm:ss{space}tmz 
where the time zone is allowed (optionally) after a space at the 
end.  

Duration This is the time span the request will cover, and is specified 
using the format integer {space} unit, where valid units are:  

S (seconds) 

D (days) 

W (weeks) 

M (months) 

Y (years) This unit is currently limited to one. 

If no unit is specified, seconds are used. 
Bar Size Specifies the size of the bars that will be returned. The 

following bar sizes may be used, and are specified using the 
parametric value: 

Bar Size 
String 

Integer 
Value 

1 SECS 1 
5 SECS 2 
15 SECS 3 
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Parameter 
Name 

Description 

30 SECS 4 
1 MINS 5 
2 MINS 6 
3 MINS 16 
5 MINS 7 
15 MINS 8 
30 MINS 9 
1 HOUR 10 
1 DAY 11 
1 WEEK 12 
1 MONTH 13 
3 MONTHS 14 
1 YEAR 15 
    

On the query return page, each "bar" is represented by a line in 
the spreadsheet. If you specify a duration of 300 seconds, and 
a bar size of "1" (one second) your return will include 300 lines, 
and the value in each line is equal to one second, or is a one-
second bar. Note that you can use either the Integer value of 
the Bar Size String or the Integer Value to define the bar sizes. 

What to Show Determines the nature of the data extracted. Valid values 
include: 

Trades 

Midpoint 

Bid 

Ask 

Bid_ Ask 

All but the Bid_Ask data contain the start time, open, high, low, 
close, volume, trade count and weighted average price during 
the time slice queried.  

For the Bid/Ask query, the open and close values are the time-
weighted average bid and the time-weighted average offer, 
respectively. These bars are identical to the TWS charts' 
candlestick bars. 

RTH Only Regular Trading Hours only. Valid values include: 

0 - all data available during the time span requested is 
returned, including time intervals when the market in question 
was outside of regular trading hours. 

1 - only data within the regular trading hours for the product 
requested is returned, even if the time span falls partially or 
completely outside. 



  

60  www.interactivebrokers.com 

Parameter 
Name 

Description 

Date Format 
Style 

Valid values include: 

1 - dates that apply to bars are returned in the format 
yyyymmdd{space}{space}hh:mm:dd (the same format used 
when reporting executions). 

2 - the dates are returned as an integer specifying the 
number of seconds since 1/1/1970 GMT. 

Page Name The name you enter will be used to name the new system-
created page into which Excel puts the historical data. 

Expired Valid values include True and False. If true, the query will run 
on an expired contract, although it is limited to the last year of 
the contract’s life, and is currently only valid for expired futures 
contracts. 

OK, so you’ve created a ticker and then entered all the query information you’ll 
need. Your spreadsheet page looks something like this: 

 

Now just click the Request Historical Data button and after a few moments, the 
API will create a new page that looks something like this: 
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Notice that the date and time, the opening price, the high and low prices and, the 
closing price, all for that bar. You also see the trading volume, the number of 
trades that occurred (trade count) per bar, and the weighted average price. 

Canceling Historical Data Requests 

To cancel historical data requests which TWS cannot process, click the Cancel 
Historical Data button at the top of the Historical Data page. If you want to 
delete one of these pages, just right click in the page title on the bottom tab, and 
select Delete. 
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Chapter 16 - The Market Scanner Page 
The market scanners use the criteria you enter along with the scan code definition 
to return X number of the top matching contracts, all in a nice, new scanner page. 
For example, you might want to know the top 30 most active stocks currently 
trading on the NYSE. You can view these results on the above mentioned nice 
new scanner page, which by the way YOU named, and can even activate a feature 
that will make this page pop to the front of your application any time there are 
additions, deletions or any other changes to the list. Let’s see how to do all this! 

 

 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 
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Element Name Description 

codes! 
Instrument Identifies the instrument type used in the scan.  

To see what instruments are available, you can look at 
the TWS Market Scanner instruments. 

Location code Identifies the market used (i.e. US Stocks) for the scan. 

To see what locations are supported, you can look at the 
TWS Market Scanner  location codes. 

Stock type filter Allows you to specify just stocks, just etfs, or both. 
Number of rows Define the number of rows of data you want returned. 
Price Above Filters out returns with prices below the named price. 

Can be left empty. 
Price Below Filters out returns with prices above the named price. 

Can be left empty. 
Average volume 
above 

Filters out returns with an average volume below the 
named price. Can be left empty. 

Average Option 
Volume Above 

Filters out returns with an average option volume below 
the named price. Can be left empty. 

Market Cap Above Filters out returns with a market capitalization value 
below the named price. Can be left empty. 

Market Cap Below Filters out returns with a market capitalization value 
above the named price. Can be left empty. 

Moody Rating Above Filters out returns with a Moody rating below the named 
price. Can be left empty. 

Moody Rating Below Filters out returns with a Moody rating above the named 
price. Can be left empty. 

S&P Rating Above Filters out returns with an S&P rating below the named 
price. Can be left empty. 

S&P Rating Below Filters out returns with an S&P rating above the named 
price. Can be left empty. 

Maturity Date Above Filters out returns with a maturity date below the named 
price. Can be left empty. 

Maturity Date Below Filters out returns with a maturity date above the named 
price. Can be left empty. 

Coupon Rate Above Filters out returns with a coupon rate below the named 
price. Can be left empty. 

Coupon Rate Below Filters out returns with a coupon rate above the named 
price. Can be left empty. 

Exclude Convertible Filters out convertible bonds. Can be left empty. 
Scanner Settings 
Pairs 

For example "Annual/True" used on the Top Option 
Implied Vol% Gainers would instruct the scan to return 
annualized volatilities. 

Delimit setting pairs by slashes.  
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Available Market Scanners 

The following table shows a list (current as of April 2008) of the available 
scanners.  

Market Scanner Parameters 

Parameter Description 

Top % Gainers Contracts whose last trade price shows the highest percent increase 
from the previous night's closing price.  

Top % Losers Contracts whose last trade price shows the lowest percent increase 
from the previous night's closing price.  

Most Active Contracts with the highest trading volume today, based on units 
used by TWS (lots for US stocks; contract for derivatives and non-
US stocks). 

Not Open Contracts that have not traded today. 
Halted Contracts for which trading has been halted. 
Hot Contracts 
by Price 

Contracts where: 

(lastTradePrice-prevClose)/avgDailyChange is highest in absolute 
value (positive or negative).  

The avgDailyChange is defined as an exponential moving average 
of the contract's (dailyClose-dailyOpen) 

Hot Contracts 
by Volume 

Contracts where: 

today'sVolume/avgDailyVolume is highest.  

avgDailyVolume is a 30-day exponential moving average of the 
contract's daily volume. 

Top Trade 
Count 

The top trade count during the day. 

Top Trade Rate Contracts with the highest number of trades in the past 60 seconds 
(regardless of the sizes of those trades). 

Top Price Range The largest difference between today's high and low, or yesterday's 
close if outside of today's range. 

Hot by Price 
Range 

The largest price range (from Top Price Range calculation) over the 
volatility. 

Top Volume 
Rate 

The top volume rate per minute. 

Highest Option 
Imp Vol 

Shows the top underlying contracts (stocks or indices) with the 
highest vega-weighted implied volatility of near-the-money options 
with an expiration date in the next two months. 

Lowest Option 
Imp Vol 

Shows the top underlying contracts (stocks or indices) with the 
lowest vega-weighted implied volatility of near-the-money options 
with an expiration date in the next two months. 

Top Option Imp 
Vol % Gainers 

Shows the top underlying contracts (stocks or indices) with the 
largest percent gain between current implied volatility and 
yesterday's closing value of the 15 minute average of implied 
volatility. 

Top Option Imp 
Vol % Losers 

Shows the top underlying contracts (stocks or indices) with the 
largest percent loss between current implied volatility and 
yesterday's closing value of the 15 minute average of implied 
volatility. 



  

www.interactivebrokers.com  67 

Market Scanner Parameters 

Parameter Description 

High Option 
Imp Vol Over 
Historical 

Shows the top underlying contracts (stocks or indices) with the 
largest divergence between implied and historical volatilities. 

Low Option Imp 
Vol Over 
Historical 

Shows the top underlying contracts (stocks or indices) with the 
smallest divergence between implied and historical volatilities. 

Most Active by 
Opt Volume 

Displays the most active contracts sorted descending by options 
volume. 

Most Active by 
Opt Open 
Interest 

Returns the top 50 underlying contracts with the (highest number 
of outstanding call contracts) + (highest number of outstanding put 
contracts) 

High Opt 
Volume P/C 
Ratio 

Put option volumes are divided by call option volumes and the top 
underlying symbols with the highest ratios are displayed. 

Low Opt 
Volume P/C 
Ratio 

Put option volumes are divided by call option volumes and the top 
underlying symbols with the lowest ratios are displayed. 

High Option 
Open Interest 
P/C Ratio 

Returns the top 50 contracts with the highest put/call ratio of 
outstanding option contracts. 

Low Option 
Open Interest 
P/C Ratio 

Returns the top 50 contracts with the lowest put/call ratio of 
outstanding option contracts. 

Hot by Option 
Volume 

Shows the top underlying contracts for highest options volume over 
a 10-day average. 

Market 
Statistics 

Lets you see exchange-specific statistics for: 

Advancing, declining and unchanged issues 

Up, down, unchanged and total volumes 

TRIN and TICK indicators  
Viewing Market Scanner Results 

Like the Historical Data subscription, the Market Scanner creates a new page 
and gives it the name you specified in the Page Name field. Your result will look 
something like this: 
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Deleting Market Scanner Results 

If you want to delete this page at any time, just right click on the tabbed title and 
select Delete. 

Cancelling a Scanner Subscription 

If a scan doesn’t seem to be processing, you can cancel it by clicking the Cancel 
Scanner Subscription button. It might also be helpful for you to see why it hasn’t 
processed - perhaps you have an invalid value somewhere along the way. To find 
out if this is the case, click the Show Errors button and look at the last error code. 
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Chapter 17 - The Contract Details and Bond 
Contract Details Pages 
The Contract Details and Bond Contract Details pages may be two of the least 
complicated, yet most useful, of all the pages. Basically, use these two pages to 
get important contract-related information that you might need to help you enter 
valid parameters on other pages. What? Well for example, you might want to find 
out what order types are supported for specific instrument on a certain exchange. 
Use the Contract Details page! Or you might need the ConID or some coupon 
information for a bond to allow you to properly request a ticker. Use the Bond 
Contract Details page! The main reason these are separated is that the contract 
information for bonds is so different from that on other instruments, we’d have 
need a billion columns on one worksheet to cover them all. 

 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 
 

Contract Details Page 

Follow the examples in the sample application to see how to enter the Summary 
Description. This basically identifies the contract for which you’re trying to find 
more information. For bonds, you will need to know the CUSIP. To see how easy 
this is, let’s use the Contract Details page and select a contract. Now, simply click 
the Request Contract Details button, and the application effortlessly displays all 
the details you might need. You’ll have to move down the list and highlight each 
instrument separately, and click the button each time. 

Expired Options 

Under the Options heading, notice that since this application was written, some of 
the options have expired. If you try to get details on these expired options, all 
you’ll get are zeros. Now, click the Show Errors button, and look at the last error 
message. It tells you that “No security definition has been found for the request.” 
In other words, this doesn’t exist anymore! If you just change the date to a valid 
expiry and request the details again, the API will be able to help you out. 

The following picture shows you the results of a contract details request. 
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Notice that the expiry date on the first option in the list has been modified.  

Bond Contract Details Page 

The Bond Contract Details page is very similar to the Contract Details page, 
aside from the column headings. And it works the same, too. Along with your 
TWS user name, you are also required to enter the contract summary description, 
so the application knows what contract you’re trying to find out about. Follow the 
examples in the sample application to see how to enter the Summary Description. 
This basically identifies the contract for which you’re trying to find more 
information. For bonds, you will need to know the CUSIP. Then you select the 
contract line and click the Request Bond Contract Details button and voila! If the 
data you entered is valid, the results appear as expected. If the data you entered 
was invalid, the results won’t display. In this case, use the Show Errors button to 
find out what went wrong, and see if you can rectify your error.  
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Using Contract Details on Other Pages 

To use any of the data from the Contract Details or Bond Contract Details 
pages on other pages, copy and paste the contents of a cell. 
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Chapter 18 – The Market Depth Page 
Market Depth shows you the alternative bids and offers away from the inside 
quote, which gives you a broader picture of what’s happening and can help you to 
better gauge market liquidity. You can also specify SUPERSOES for instruments 
that trade on Nasdaq and receive Level II Nasdaq market quotes. 

 

 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 
 

View More Than Ten Rows of Market Depth 

By default, the Excel page is set up to receive ten rows of market depth. This 
means that when you enter the contract summary description, you need to leave 
ten blank lines before you enter another. If the contract you entered doesn’t have a 
depth of at least ten it won’t get filled.  

Now, if you want to see more than ten lines, you can modify the value in the 
reqMktDepth macro. Here’s what to do: 
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Chapter 19 – The Old Style Executions and 
Account-Portfolio Pages 
The development team left two vestiges of the old-style screens: the Old Style 
Executions  and the Old Style Account -Portfolio  screens. They present the same 
data as the newer Executions, Account and Portfolio pages, but require you to 
click a button for each line of data. In addition, the latest and more efficient 
versions of both also break out the Account and Portfolio features to two pages, 
and include a new Executions Reporting page. These pages were left intact in 
deference to users who already have code linked to them. If by chance you 
happen to be one of these users, you should probably think about ending your 
dependence on these pages, and start using the “new fangled” pages instead. 

 

As always, make sure TWS is running, and don’t forget to enter your 
username in the User Name field! 

 

Old Style Executions 

The Old Style Executions  page displays the current day’s executions. As always, 
the most important thing to remember is to enter your username to identify the 
trader workstation to which you’re linking up. Then click the Request Executions 
button. Each time you click you get one execution report. If you scroll to the right 
you’ll see the Execution Filter Criteria box. You can elect to only see specific 
reports by entering a value in any of these filter fields. For example, if you enter 
NYSE in the Exchange field, you’ll only get results for executions on the NYSE. 

Old Style Account-Portfolio 

The Old Style Account -Portfolio  page displays everything about the status of 
your account and portfolio. Once you’ve entered your TWS username, simply 
click the Req Account Value button for each line of account information you want 
to view. The 32 lines in the Account Values section will all be filled with values, 
from your Equity with Loan Value through your margin and P&L values. The 
Account Portfolio section will display your portfolio for all of your current 
positions. 
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Part IV: Creating Your Own API Application 
In this section, you’ll be leaving the world of the known, and venturing into new 
territory. Now that you’re familiar with the DDE for Excel API and how it works, 
it’s time to leave the nest and make your own way. And we know that this is why 
you’re really here - to find out how to manipulate the API to create an application 
that does what YOU want, and it’s probably something you can’t find anywhere 
else. This section shows you the basics of using the VBA editor, and provides a 
few samples of some real-life API application scenarios a customer might want to 
implement.  

Here’s what you’ll find in this section: 

• Chapter 20 – Download the Samples 

• Chapter 21 – Using VBA to Customize the API 

• Chapter 22 – Sample Applications for the API 
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Chapter 20 – Download the Samples 
Along with the samples, we’ve also put together a whole DDE Excel worksheet 
with the code included, which you can download to your local drive directly from: 

http://individuals.interactivebrokers.com/en/p.php?f=programInterface&p=a& 
ib_entity=lic, click the Proprietary API tab, then click Getting Starting Guide to 
display the page with the downloadable samples. 

In the course of viewing and perhaps modifying these sample scenarios, you’ll get 
a little bit of a feel for how VBA works, and maybe you’ll even get some new 
ideas of situations you’d like to create yourself. Of course, in order to protect your 
million-dollar idea, you’ll have to implement your ideas on your own. We include 
a list of some helpful VBA reference books and other outside help in Chapter 23 – 
Additional Resources. 

 

http://individuals.interactivebrokers.com/en/p.php?f=programInterface&p=a&ib_entity=lic�
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Chapter 21 - Using VBA to Customize the API 
The Excel pages have been deliberately designed to give you easy access to the 
Visual Basic for Applications code that sits behind its functionality. Specifically: 

• Using named ranges to assign meaningful names to ranges of cells makes 
it easier for you to move data around on a worksheet without breaking the 
existing logic. It also makes this data available to other worksheets, and to 
user-written macros. 

• Each worksheet page that includes buttons has that button’s macro logic in 
its own VBA rather than in worksheet-wide modules. This makes the 
VBA that does work on a specific page easier to find and understand, and 
makes it easier for you, the user, to add functionality to an existing 
worksheet, or to base the code in a new custom-built worksheet on that of 
one of our pre-existing worksheets. 

• Functions are divided into four modules: ArrayQueries, ErrorDisplay, 
Orders, and util.  

• You’ll find the functions in the util module particularly helpful in building 
new VBA functionality. For example, the composeLink function puts 
together a link that receives data such as the bid size, execution ID or 
option model volatility. The composeContractReq function reads a 
contract description right out of another page, like the Tickers  or Orders 
page, and builds the DDE  string representing it. 

Now let’s take a look at how you can access all of this VBA stuff! 

Using the Visual Basic Editor (VBE) 

The Visual Basic Editor, which we shall from this point forward call “VBE,” is a 
separate application, but you can only open it and access the TWS VBA code 
when the Excel spreadsheet is up and running. If you took a look at any of the 
macros in the previous chapters, you’ve had a glimpse of this illustrious 
programming tool.  

From the Excel interface, open one of the pages by clicking a tab at the bottom of 
the screen, say the Executions  Reporting tab. OK, now open the VBE by clicking 
Alt + F11. See? Not only does the editor open, but it opens with the active sheet 
selected in the Project Explorer section, in this case Sheet.16 (Executions 
Reporting).  
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Looking at the Visual Basic Editor 

Here’s what you’re looking at: 

 

 

 

 

 

The Project Explorer shows a tree diagram that lists all projects (we have only 
one project which is called TwsDde.xls), at least one node (in this example it’s 
Microsoft Excel Objects), and the objects contained in the node. You’ll notice 
that the Microsoft Excel Objects correspond to the pages in the DDE for Excel 
API spreadsheet. The VBA Project Explorer also shows an object called This 
Workbook which holds any VBA modules. The Excel  spreadsheet includes a 
clearLinks module for each worksheet, which you see as a button on the Tickers  
page called Clear All Links. This piece of code removes all DDE links to TWS  
that the VBA (which IB provided) could create. This does things like canceling 
market data, historical data and scanner subscriptions, and prepares your 
worksheet to be saved to disk. If you were to add some of your own custom links, 

Code Window 

Project Explorer 

Properties Window 
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You’re going to record your actions as you click in the User Name cell 
and enter your TWS User Name. You’ll assign a hotkey (say, Ctrl + U), 
and then when you open a new page, you’ll only need to press Ctrl + U to 
enter your user name on the page.  

2. Next, start the macro recorder. This is simpler than clicking the record 
button on your VCR.  

3. On the Tools menu, select Macro, then click Record New Macro. A little 
information box opens, and you’ll want to oblige it by entering some 
useful information.  

If you are using Excel 2007, click the View tab, then click the down arrow 
on the Macros button and select Record Macro from the drop-down menu. 

4. Type the name of your macro. (For example, you can name your macro 
“AutoUserName” for two reasons: first, it’s descriptive so you can 
remember what it does, and second it begins with the letter “A” so it will 
be right at the top of the macro list and easy to find.)  
 

 

5. Now enter a shortcut key which you’ll press along with the “Ctrl” key to 
activate the macro. You’re going to keep it in This Workbook, and leave 
the default description, so we’re done here. Click OK to start the recorder.  

Be aware that any keys you press at this point, or any click of the mouse, 
will be recorded, so don’t do anything! You want to keep this as clean as 
possible so you won’t have to go in later and remove lots of extraneous 
VBA code. 



  

www.interactivebrokers.com  81 

6. Click in the User Name entry box, type your username and press Enter. 

7. Stop the recording process by clicking the blue square STOP button on the 
recorder. 

If you are using Excel 2007, click the View tab, then click the down arrow 
on the Macros button and select Stop Recording from the drop-down 
menu. 

Next, you’ll, oh - wait a minute. You’re done. Yes, really, that’s it! But don’t get 
too excited yet - there’s one catch to this particular example macro. Next you’ll 
run the code and see what happens. 

Run the Macro 

Now try running the macro. 

1. On the Tickers page, delete your user name from that field, then run your 
new macro by clicking the hotkey combination, which in your example 
would be Ctrl + U.  

You should see your username magically appear in the field. Don’t worry 
if you made a typo, we’ll be going into the editor and you can fix it there. 
Now you may be thinking to yourself “Hey, but you said there was a 
catch! What’s the catch?” 

2. Open the Orders  page, and use your macro again.  

HUH? What just happened? Your username ended up in the wrong place, that’s 
what happened! When you recorded the macro, the exact location of the entry cell 
you used was recorded, and on the Tickers  page that User Name cell is B5. It 
just so happens that on all of the other pages it’s D5! Your macro is good, but it 
can’t reason, it can only use the information you gave it. It has no idea, and really 
doesn’t care either way, if the results are what you had hoped for.  

But this isn’t such terrible news, because it gives you a chance to go into the VBA 
code, take a look at what’s going on and make a minor change to make the code 
slightly more useful. 

Look at the Code 

Let’s take a look at the macro.  

Select Macro from the Tools menu, then Macros from the menu. If you are using 
Excel 2007, click the View tab, then click the Macros button), and find your 
macro in the list. Your macro should appear at the top of the list. Next, select your 
macro, and then click the Edit button to open it in the VBE Editor. 
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Modules 

Notice that you’re in the VBE editor, and Modules is highlighted in the Project 
Explorer. Although you named the macro, you didn’t name this module, so do 
that now so it’s easier to find in the future.  

 

In the Properties window, click the name Module1 and enter a new name. In the 
hierarchy of things, the Module is the container of the macro (or sub procedure) 
and could ultimately be home to more of these macros, so you don’t want the 
Module name to be the same as your macro. We could call it something like Tests 
and put anything we want to play with in this module. 
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The Actual Code 

Now look to your right, and you’ll see your macro sitting there, just waiting. 
Although at first glance this might look like Greek to you, if you take just a 
second longer, you’ll start to make sense of some of it, especially if you think 
back to what you just recorded. 

First, at the top and bottom in blue text you see the words “Sub” and then “End 
Sub.” These tell you that what lies between is a little piece of code called a sub 
procedure (or routine). Note that words in green have a single quote in front of 
them. This indicates that they are “comments” and they’re not part of the code. 
Once you put the single quote in, you can type an explanation or description, 
whatever you want, and VBA won’t try to do anything with it.  

Next you come to the VBA code that your little macro created, and you might 
recognize the notorious cell, B5, in the Range.Select method. Let’s change this 
value to “D5” instead (this simple change will make the macro work on all pages 
EXCEPT the tickers page, but we really just want to make a change and see it 
work) and if you mistyped your username, this is where you can correct it. In 
addition, after you entered the username during the recording session, remember 
that you pressed the Enter key. That action is reflected in the Range (“B6”).Select 
method, but you really don’t want to select another cell, so just delete that line 
altogether, and then save your work. If you run your macro on any of the pages 
other than the Tickers page, now you’ll get an accurate result. 

Chapter 22 includes some useful and more complex code samples that you’ll want 
to explore moving forward.  
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Chapter 22 - Sample Applications for the API 
We’ve included five real-life samples to help you get a feel for what you can do 
with the DDE for Excel API, beyond the features already included for you. Your 
best bet for exploring these samples is to open the Excel spreadsheet you’ll find 
via the Samples link below, and run it against your TWS.  

For each sample , we’ve include a detailed description including its primary 
raison d’être. And along with getting the chance to examine some VBA code and 
see some cool stuff, you can save the sample spreadsheet in your local directory 
with another name, and use the code as your own!  

The list below includes an overview of each sample. If you click the title, you’ll 
go directly to the page that gives more specific details on the example. 

Samples Overview 

• Sell based on P & L - Sell positions with a P&L greater than or equal to a 
user-defined trigger value. 

• Buy/Sell based on Top Implied Volatility Gainer Market Scan results - 
Based on the ranked results in the TOP_OPT_IMP_VOL_GAIN market 
scanner, this sample  macro buys the top 3 gainers, then sells them when 
their ranking falls lower than number 5.  

• Export Daily Executions - Export your daily executions to a comma-
delimited text file when you close the spreadsheet. You can then open this 
file from a new Excel spreadsheet to see the data in Excel format. 

• Excel OptionTrader - Creates an OptionTrader-like screen in Excel, and 
also and provides a default strike price based on the current market price 
and a default expiry date based on the current date. 

• Currency Converter- Convert cash values on the Portfolio  page (which 
display in your base currency) to another currency. This macro only works 
if you have the currency in your account (i.e. via a Forex trade), since the 
macro needs the conversion rate. 
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Download the Samples 

Download the TwsDdeBeginners.xls spreadsheet right onto your computer to have 
instant access to the code and the new worksheets.  

To get the spreadsheet, go to: 

http://individuals.interactivebrokers.com/en/p.php?f=programInterface&a&ib_ent
ity=lic.  

Then click Getting Started Guide to display the page with the downloadable 
samples.  

Example 1 : Sell based on P & L 

The code for this macro is in the Example1 module. Use the Alt + F11 hotkey 
combination to open the VBE editor, and in the Project Explorer open the 
Modules directory and double click Example1.  

 

 

 

http://individuals.interactivebrokers.com/en/p.php?f=programInterface&a&ib_entity=lic�
http://individuals.interactivebrokers.com/en/p.php?f=programInterface&a&ib_entity=lic�
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Modify the P&L Trigger Value 

The purpose of this sample 

 

  is to sell open positions in your portfolio that have: Realized P&L + Unrealized 
P&L >= a pre-defined value. This pre-defined value is stored in a variable called 
P_AND_L_TRIGGER_VALUE and is set to 50. You can modify the value of the 
P&L Trigger Value variable by changing the value in the declaration: 

Public Const P AND L TRIGGER VALUE = 50. 

Limit the Sample to a Specific Stock 

By default, the sample goes through your entire portfolio, but you can customize 
it to look at just stocks, a specific stock, or any other criteria you choose. For 
example, to limit the sample to just Microsoft stock1, add the following code 
highlighted below in bold: 

If position > 0 And secType = “STK” And symbol = “MSFT” 
Then 
  If (unrealizedPandL + realizedPandL) > 
P_AND_L_TRIGGER_VALUE Then 
   If ExampleUtil.createOrder("SELL", symbol, secType, 
expiry, strike, right, currencyCde, position, "", "P&L") 
Then 
     logSuccess = logMessage("[automateTrade]", "Automated 
market SELL order successfully created for: " & symbol) 
   End If 
  End If 
End If 

Save your changes. When the trigger value is reached, a sell market order is 
created. This information is logged on the worksheet titled “Auto Orders.” The 
results of the order will then appear on the other worksheets that have subscribed 
to account changes, for example, “Executions” and “Portfolio”. 

Enable or Start the Subroutine 

This subroutine runs in the background. It can be enabled when first opening the 
spreadsheet or enabled by clicking the Start button on the “Auto Orders” screen 
for “P&L” (scroll to the right until you see the button). The scheduling is 
controlled by the variables RUN_WHAT and RUN_INTERVAL_SECONDS. 
RUN_WHAT contains the macro name, i.e., Example1.automateTrade and 
RUN_INTERVAL_SECONDS contains how often the macro should run, i.e., 900 
seconds (15 minutes). 
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Code Summary 
Module(s)/Subroutine(s): 
 

Example1  
automateTrade() – The subroutine that monitors 
P&L for your open positions  
startTimer() – Starts the P&L background macro 
stopTimer() – Stops the P&L background macro 

ExampleUtil 
Contains common functions for the examples 

New Worksheet(s) 

The “Auto Orders ” page was created to log the orders that are initiated by 
background macros. It also contains controls to start/stop the background macros. 

Example 2 : Buy/Sell based on Top Implied Volatility Gainer 
Market Scan Results  

The code for this macro is in the Example2 module. Use the Alt + F11 hotkey 
combination to open the VBE editor from any page in the sample spreadsheet, and 
in the Project Explorer open the Modules directory and double click Example2.  
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How Does the Sample Work? 

The purpose of this sample is to buy the top three implied volatility gainers and 
sell them when they are no longer ranked within the top five. 

The subroutine first checks that the TOP_OPT_IMP_VOL_GAIN market scanner 
is running. If not, the macro cannot run, so you will need to start up this scanner 
(go to the Market Scanner page, select the TOP_OPT_IMP_VOL_GAIN row and 
click the Start Scanner Subscription button). If so, the three top-ranked stocks are 
selected, and if the stock is not already in your portfolio, the macro does the 
following: 

1. Gets the current available funds for the account. 

2. Multiplies the available funds by a pre-defined percent. This is how much 
you are willing to spend on the stock. (This pre-defined value is stored in a 
variable called PERCENT_OF_AVAIL_FUNDS and has the default 
setting of 0.1. You can modify this setting by changing the value in the 
declaration: 
 
Public Const PERCENT_OF_AVAIL_FUNDS = 0.1. 

3. Gets the current ask price for the stock 

a. Note that in order to obtain the ask price, you need to have the 
ticker already running on the Tickers  page. It will auto-create the 
ticker if not there, but in that case cannot immediately get the ask 
price due to a delay in processing. On the next run of the macro (it 
runs every 2 minutes), it will pick up the ask price. 

b. The ask price is needed to determine how many positions to buy. 
TWS  provides more order choices than does the Excel  API. For 
instance, it would be better to just specify how much total money to 
apply to purchase instead of having to state how many positions to buy. 

4. To get the number of positions to buy, it divides the allowed available 
funds by the ask price rounded to nearest integer. 

5. Places a buy market order for the stock 

For each of the three top stocks (previous top stocks), the macro continuously 
checks to see if the stock’s rank has fallen below the fifth position. If it has, the 
macro then checks to see if there are open positions in the portfolio. If so, a sell 
market order is created. This occurs for each run of the macro, except the first run 
when there are no “previous top stocks.” 
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As in Example1, the information is logged on the worksheet titled “Auto Orders.” 
The results of the order(s) will then appear on the other worksheets that have 
subscribed to account changes, for example, “Executions ” and “Portfolio .” 

Enable or Start the Subroutine 

Before you start this subroutine, make sure you have subscribed to account 
updates on the Account page, have requested market data for all the stocks listed 
on the Tickers page. 

This subroutine runs in the background and can be enabled when you first open 
the spreadsheet, or by clicking the “Start” button on the “Auto Orders ” screen for 
“VOL.”. The scheduling is controlled by the variables RUN_WHAT and 
RUN_INTERVAL_SECONDS. The RUN_WHAT variable contains the macro 
name, i.e., Example2.watchVolatilityGainers, and the 
RUN_INTERVAL_SECONDS variable contains how often the macro should run, 
i.e., 120 seconds. 

Code Summary 
Module(s)/Subroutine(s): 
 

Example2  
watchVolatilityGainers() – The subroutine that 
monitors top volatility gainers. 
startTimer() – Starts the VOL background macro. 
stopTimer() – Stops the VOL background macro. 

 ExampleUtil 
Contains common functions for the examples. 

New Worksheet(s): 

The “Auto Orders ” sheet was created to log the orders that are initiated by 
background macros. It also contains controls to start/stop the background macros. 
This is the same worksheet used for Example1, Sell based on P & L. 
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Example 3 : Export Daily Executions 

The code for this macro is in the Example3 module. Use the Alt + F11 hotkey 
combination to open the VBE editor, and in the Project Explorer open the 
Modules directory and double click Example3.  

 

How Does the Sample Work? 

The purpose of this sample  is to export your daily execution reports to your local 
system in a comma delimited format which can then be viewed a new spreadsheet 
or used in many other clever ways! This macro is designed to run when you exit 
the Excel application. 

The macro will first check that there is data available on the Executions screen. If 
there is, it will create a destination file (variable DestFile) with the file name 
format: C:\TWSExecutions_$userName_$date.txt. You can change the file 
destination by modifying the directory in this variable. The macro will then write 
all the executions data to the file in comma delimited format. 

To view this data in another worksheet, open the .txt file in Excel, and follow the 
wizard to view the comma-delimited data. 
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Run the Macro 

This macro is set to run when the spreadsheet is closed. This is managed in the 
Workbook_BeforeClose() subroutine that is part of the ThisWorkbook object. 

Code Summary 
Module(s)/Subroutine(s):  
 

Example3  
exportExecutions() – The subroutine that performs 
the export 

 ExampleUtil 
Contains common functions for the examples 

 ThisWorkbook 
Workbook_BeforeClose() – Executes the export 
before close 

New Worksheet(s): 

None 
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Example 4 : Create DDE “OptionTrader”  

The code for this macro is in the Example4 module. Use the Alt + F11 hotkey 
combination to open the VBE editor, and in the Project Explorer open the 
Modules directory and double click Example4.  

 

How Does the Sample Work? 

The purpose of this sample  is to provide a screen similar to the TWS  
OptionTrader. In addition, it provides extra function of a default strike price based 
on the current market price, and a default expiry date based on the current date. 

Use the new Options Trader page, and enter the underlying symbol in the 
Underlying field. Click the Get Quote button to create a ticker for the underlying 
in the Quote Panel. Cool! 

Now click the Load Chains button. This subroutine will take the market price 
from the ticker (bid + ask) / 2 and generate a list of the five closest strike prices. 
Next, the subroutine determines the next two months for expiry. The call and put 
tickers are then created using the five closest strikes and the next two expiries.  

Code Summary 
Module(s)/Subroutine(s):  
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Example4  
getQuote() – The subroutine that loads the ticker 
for the underlying. 
loadChains() – The subroutine that loads the 

 option chains for the underlying. 
 ExampleUtil 

Contains common functions for the examples 

New Worksheet(s): 

The OptionTrader page contains a format similar to the TWS  OptionTrader. It 
provides the buttons Get Quote and Load Chains, which (surprisingly enough!) 
are used to call the getQuote() and loadChains() macros! How’s that for 
coincidence? 

Example 5: Currency Converter 

The code for this macro is in the Example5 module. Use the Alt + F11 hotkey 
combination to open the VBE editor, and in the Project Explorer open the 
Modules directory and double click Example5.  
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How Does the Sample Work? 

The purpose of this sample  is to convert base currency for values in the portfolio 
to the currency you enter in the new Convert base to: field. The catch to this 
macro is that you must have the currency already in your portfolio so that the 
macro can get the conversion rate.  

Go to the Portfolio page and scroll to the right to see the new conversion fields. 
In the Convert base to field, enter a currency and click Go. As long as the 
currency exists in your account, a conversion rate can be obtained. Otherwise, you 
won’t be able to run this sample. If you’re testing this with a PaperTrader  or 
demo account, you can make some Forex trades to get some currencies in your 
portfolio and then run this again to see how cool it is. Of course if you’re using 
your regular account, you might not want to be so cavalier with your money! 

 

Note that for each row in your Portfolio , conversions will be made as long as the 
currency of the position is in the base currency. If the record is not in the base 
currency, the data in the conversion section will remain blank. The conversion 
rate is also displayed along with the currency code. 

Code Summary 
Module(s)/Subroutine(s):  
 

Example5  
convertPortfolioData() – The subroutine that 
performs conversion 

 ExampleUtil 
Contains common functions for the examples 

Modified Worksheet(s): 

The “Portfolio ”page was modified by extending the matrix with the following 
columns: Market price, Market value, Avg cost, Unrealized value and Realized 
value. An input field for currency was added along, with the Go button to perform 
the conversion and the Rate field to display the current conversion rate. 
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Part V: Where to Go from Here 
If you’ve come this far and actually read the book, you now have a pretty decent 
grasp on what the DDE  API can do, and how to make it do some of the things 
you want. Now we’ll suggest some helpful outside resources you can use to help 
you keep moving forward.  

Here’s what you’ll find in this section: 

• Chapter 23 – Additional Resources 

• Chapter 24 – The DDE for Excel API for Advisors 
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Chapter 23 – Additional Resources 
There are many resources out there that will be adequate in getting you where you 
need to go. If you have some books or places that you like, feel free to stick with 
them. The following are the resources we find most helpful, and perhaps they’ll 
be good to you, too! 

Help with Visual Basic for Applications Programming 

For VBA help, your primary and first best resource should be the VBA help that 
comes with the program. To access this help, just press the F1 key from within the 
VBA. If you have a specific word highlighted the help will be specific to that 
topic; otherwise you’ll get the opening page in the right pane, and a table of 
Contents, Answer Wizard and Index on the left. It’s very well organized, but the 
best feature is the context-sensitivity. If you become comfortable with this tool 
you’ll never be sorry. 

For a broader view of VBA, a book might give you more. We recommend any of 
the following publications, some more basic than others: 

Walkenbach, John. Excel 2003 Power Programming with VBA. Indianapolis, IN: 
Wiley Publishing, 2004. 

Jacobson, Reed. Microsoft Excel 2002 Visual Basic for Applications Step-by-
Step. Redmond WA: Microsoft Press, 2001. 

Bovey, Rob et al. Excel 2002 VBA: Programmers Reference. Indianapolis, IN: 
Wiley Publishing, 2003. 

Walkenbach, John. Excel VBA Programming for Dummies. Indianapolis, IN: 
Wiley Publishing, 2004. 
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Help with the TWS API 

For help specific to the Excel TWS API, the one best place to go, really the 
ONLY place to go, is the Interactive Brokers website. Once you get there, you 
have lots of resources. Just type www.interactivebrokers.com in your browser’s 
address line. Now that you’re there, let me tell you where you can go. 

Hold on - first we need to clarify to you that, as of this writing in November of 
2006, the IB website looks as we’re describing. IB has a tendency to revamp the 
look and organization of their site every year or two, so have a little patience if it 
looks slightly different from how it is described in this book. Here are the best 
places to find API help: 

The API Reference Guide  

The API Reference Guide includes sections for each API technology, including 
the DDE  for Excel. The upper level topics which are shown directly below the 
main book are applicable across the board to all or multiple platforms.  

• To access the API Reference Guide, from the IB web site click Software 
> Application Programming, then click the Proprietary API tab, then 
click Reference Guide. Click the Online Guide button to open the online 
guide, which contains a section devoted entirely to the DDE for Excel 
API. 

The API Beta and API Production Release Notes 

The beta notes are in a single page file, and include descriptions of any new 
additions to the API (all platforms) that haven’t yet been pushed to production. 
The API Release Notes opens an index page that includes links to all of the past 
years’ release notes pages. The index provides one-line titles of all the features 
included in each release.  

• To access these notes, from the IB web site click Software > Application 
Programming, then click the Proprietary API tab, then click either API 
Beta Notes or API Release Notes. 

The API Highlights 

This publication is very high level and designed to touch upon some key features 
of the different API platforms. It’s most helpful as an aid in choosing the type of 
access technology you’ll use to design your API. But if you are not a programmer, 
you’ll probably want to stick with the DDE  for Excel.  

http://www.interactivebrokers.com/�
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• To view the API Highlights, from the IB web site click Software > 
Application Programming, then click the Proprietary API tab, then click 
Beginner’s Guide, then select the API Highlights link in the text. 

The TWS API Tour 

The API tour presents a broad view of the API, its different access technologies, 
and a quick look at the DDE /Excel version. IB provides a page with different 
teaching tour that you can access from our web site. Click Education > 
Interactive Tours, then select the IB Application Program Interface Tour link. 

The TWS API Webinar 

IB hosts free online webinars through WebEx to help educate their customers and 
other traders about the IB offerings. They present the API webinar about once per 
month, and have it recorded on the website for anyone to listen to at any time. 

• To register for the API webinar, from IB web site click Education > 
Webinars. On the Live Webinars page, click the Application Program 
Interface tab, then click the TWS Application Programming Interface 
(API) expandable topic. You will find a brief description of the webinar, 
the date and time of the next presentation, and a registration link.  

• To view the recorded version of the API webinar, from the Live Webinars 
page click the Watch Previously Recorded Webinars button. Links to 
recorded versions of previously recorded webinars are listed on the page. 

API Customer Forums  

You can trade ideas and send out pleas for help via the IB customer base 
accessible through both the IB Bulletin Board and the Traders’ Chat. The 
bulletin board includes a thread for the API, and thus provides an ongoing 
transcript of questions and answers in which you might find the answer to your 
question. The Traders’ Chat is an instant-message type of medium and doesn’t 
retain any record of conversations.  

• To view or participate in the API Traders Chat, from the IB web site 
click Education > Bulletin Boards & Chats, then select the API Chat 
page and click the Launch API Trader Chat button. 

• To view or participate in the IB Bulletin Board, from the IB web site 
click Education > Bulletin Boards & Chats, then select the Bulletin 
Board page and click the Launch IB Discussion Forum button. 

• To participate in the Traders’ Chat, from click the Chat button in TWS. 
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IB Customer Service 

IB customers can also call or email customer service if you can’t find the answer 
to your question, but IB makes it clear that the API is designed for use by 
programmers and that their support in this area is limited. Still, the customer 
service crew is very knowledgeable and will do their best to help resolve your 
issue. 

• From the IB web site, click Help & Contacts > Customer Service, where 
you can send an inquiry to Customer Service or get other important 
information about IB Customer Service. 

IB Features Poll 

The IB Features Poll lets IB customers submit suggestions for future product 
features, and vote and comment on existing suggestions. 

• From the IB web site, click About IB > New Features Poll. Suggestions 
are listed by category; click a plus sign next to a category to view all 
feature suggestions for that category. To submit a suggestion, click the 
Submit Suggestion link. 
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Chapter 24 – The DDE for Excel API for 
Advisors  
Much of the content included is applicable to both individual traders and advisors, 
but there are some specific areas of interest for those of you who handle multiple 
clients. This section focuses on the features that are only available to multi-client 
account advisors. 

Note that at this time, although you can allocate portions of an order to multiple 
accounts via the DDE  API, you must first configure account groups, account 
profiles, methods and percentages manually through the TWS . You can check the 
TWS Users Guide on the IB website  for instructions on how to do this. 

Setting Up Orders for an Advisor  

Let’s take a look at how to set up an order for an advisor using a single account, 
an account group, and an allocation profile. But first let’s draw a hypothetical 
picture of who you are, with a descriptive scenario and some nuggets of 
information on which we’ll base our share allocation examples: 

• You are account number DF16045, and you manage 3 subaccounts named 
DU16046, DU16047, DU16048. 

• In TWS , you have created an Account  Group called LowRisk, added all 
the subaccounts to this group, and selected AvailableEquity as that group’s 
default allocation method. This method dictates that the total number of 
shares in an executed order will be split between the accounts in the group 
based on the ratio of their available equity. If account DU16046 has 
available equity in the amount of $25,000, DU16047 has $50,000 and 
DU16048 has $100,000, the ratio is 1:2:4, and an order for 700 shares 
would see DU16046 with 100 shares, DU16047 with 200 shares and 
DU16048DU10705 with a whopping 400 shares of the order! 

• In TWS, you have also created an Allocation Profile that you call 
HighRisk, set the allocation specifics to Percentages, and allocated 65% 
to DU16046 and 35% to DU16048. When you use this Allocation Profile, 
the total executed order quantity will be split 65/35. 

That’s all you need to know for now. Let’s put our focus back on the Excel 
spreadsheet and allocate some shares!! 

Allocate All Shares to a Single Account 
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Set up an order to buy 300 shares of YHOO1 at the market price, and allocate all 
the shares in the order to a single account, say DU16047. OK, it sounds simple, 
but how do actually do it? 

First open the Orders  page, and make sure you‘re linked up to your TWS  
account.  

Enter the order description information as shown in the following figure: 

 

Now, you need to use the Extended Order Attributes . As we discussed earlier, 
you can enter these attributes on a per order basis using the area on the order line, 
or you can leave all that alone and use the Extended Order Attributes page. The 
catch is, some of these need to have a value of “0” to indicate that you don’t want 
to use them, and it’s easier to leave these filled out on the page than to go through 
and enter them manually for every order. Start by using the Extended Order 
Attributes page and end by viewing these same attributes on the order line itself. 

Open the Extended Order Attributes page. In this case, where you’re giving the 
entire order to one account, you only need to use one of the attributes, specifically 
the Account  field. It’s labeled “Institutional Only” but don’t let that scare you, it’s 
for you too! 

Enter the account number in the field, and while you’re in there take a look and 
see the other fields that contain values. You’ll see something similar to the 
following figure: 
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Remember, you only entered a value in the Account  field, the other values are 
there by default.  

Now let’s go back to the Orders  page and scroll to the right to where you can see 
the Extended Order Attributes cell, which are all dark gray by default. Note that at 
this point, there are no values in any of these fields.  
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Advisor Fields 

That’s all folks! Except for reference, we’ve put together a table that tells you a 
bit about each of the advisor-oriented fields. 

Advisor Field Description  Valid Values 

Account  Used to allocate all shares of an 
order to a single account.  

Use on the Orders  page and 
Extended Order Attributes  
page. 

A valid account number. 
Note that an account alias 
WILL NOT be recognized. 

To see a list of your 
managed accounts, click the 
Request Managed Accounts 
button on the Account  
page. 

FA Group An advisor-defined account group 
comprising a set of subaccounts to 
which executed shares will be 
allocated based on an associated 
method. 

Use on the Orders  page and 
Extended Order Attributes  
page. 

If you enter a value in this 
field, you also need a value 
in the FA Method field. 

FA Method* Defines the allocation method for 
the subaccount within an account 
FA group. 

Use on the Orders  page and 
Extended Order Attributes  
page. 

EqualQuantity 

NetLiq 

AvailableEquity 

PctChange 

FA Percentage If the FA Method is PctChange, 
enter the percentage in this field. 

Use on the Orders  page and 
Extended Order Attributes  
page. 

This method can only be 
used to modify an existing 
position. 

FA Profile* A profile allocates order shares to 
specific accounts by percentage, 
ratio, or an absolute number. 

Use on the Orders  page and 
Extended Order Attributes  
page. 

Enter the name of the FA 
Profile. The allocation 
specifics have already been 
defined via TWS . 

Acct Code  Found only on the Account  page, 
used to define that account to 
which you want to subscribe.  

A valid account number. 
Note that an account alias 
WILL NOT be recognized. 

To see a list of your 
managed accounts, click the 
Request Managed Accounts 
button. 
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Advisor Field Description  Valid Values 

Request 
Managed 
Accounts button 

Located on the Account  page, 
used to view a list of valid account 
numbers. 

N/A 

FA Managed 
Accounts 
received cell. 

After you click the Request 
Managed Account  button, the 
account values are displayed in 
this cell. 

N/A 

*Refer to Appendix C for more details and examples on each of the listed 
allocation methods and profiles. 

In Summary… 

Well, you’ve done it. You’ve made your way through the book, and you’re still 
alive to talk about it! And along the way you’ve created the beginnings of your 
own Application Programming Interface. Hopefully you’ve also lain to rest some 
of the fears you had about tackling this type of project. It’s not so intimidating 
when you break it down and take the time to focus on each piece separately.  
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Appendix A – Extended Order Attributes  
Attribute Valid Values 

timeInForce DAY 

GTC 

OPG 

IOC 

ocaGroup String 

account The account number, used for institutional and advisor accounts. 

open/close O, C (for institutions) 

origin 0, 1 (for institutions) 

orderRef String 

transmit 0 (don't transmit) 

1 (transmit) 

Parent order Id String (the order ID used for the parent order, use for bracket and auto 
trailing stop orders) 

blockOrder 0 (not a block order) 

1 (this is a block order) 

sweepToFill 0 (not a sweep-to-fill order) 

1 (this is a sweep-to-fill order) 

displaySize String (publicly disclosed order size) 

triggerMethod Specifies how simulated Stop, Stop-Limit, and Trailing Stop orders are 
triggered.  

O - the default value. The "double bid/ask" method will be used for orders 
for OTC stocks and US options. All other orders will use the "last" method. 

1 - use "double bid/ask" method, where stop orders are triggered based 
on two consecutive bid or ask prices. 

2 - "last" method, where stop orders are triggered based on the last price. 

3 - "double-last" method, where stop orders are triggered based on last 
two prices. 

4 – “bid-ask” method. For a buy order, a single occurrence of the bid price 
must be at or above the trigger price. For a sell order, a single occurrence 
of the ask price must be at or below the trigger price. 

7 – “last-or-bid-ask” method. For a buy order, a single bid price or the 
last price must be at or above the trigger price. For a sell order, a single 
ask price or the last price must be at or below the trigger price. 

8 – “mid-point” method, where the midpoint must be at or above (for a 
buy) or at or below (for a sell) the trigger price, and the spread between 
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Attribute Valid Values 

the bid and ask must be less than 0.1% of the midpoint. 

Hidden Only valid for orders routed to Island. 

0 - False 

1 (order not visible when viewing market depth) 

Discretionary 
Amount 

Used in conjunction with a limit order to give the order a greater price 
range over which to execute. 

Good After 
Time 

Enter the date and time after which the order will become active. Use the 
format YYYYMMDD hh:mm:ss 

Good 'Till Date The order continues working until the close of market on the date you 
enter. Use the format YYYYMMDD. To specify a time of day to close the 
order, enter the time using the format HH:MM:SS. Specify the time zone 
using a valid three-letter acronym. 

FA Group For Advisor accounts only. The name of the Account Group. 

FA Method For Advisor accounts only. The share allocation method. 

EqualQuantity 

NetLiq 

AvailableEquity 

PctChange 

FA Percentage For Advisor accounts only. The share allocation percentage. 

FA Profile For Advisor accounts only. The name of the Share Allocation profile. 

Short Sale Slot For institutional accounts only; for SSHORT actions. 

1 – If you hold the shares 

2 – Shares will be delivered from elsewhere.  

Short Sale 
Location 

If shares are delivered from elsewhere, enter where in a comma-delimited 
list with no spaces. For institutional accounts only. 

OCA Type 1 = Cancel on Fill with Block 

2 = Reduce on Fill with Block 

3 = Reduce on Fill without Block 

Rule 80A Individual = 'I' 

Agency = 'A',  

AgentOtherMember = 'W' 

IndividualPTIA = 'J' 

AgencyPTIA = 'U' 

AgentOtherMemberPTIA = 'M' 

IndividualPT = 'K' 

AgencyPT = 'Y' 

AgentOtherMemberPT = 'N'  
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Attribute Valid Values 

Settling Firm Institutions only 

All or None 0 = false 

1 = true 

Minimum Qty Identifies the order as a minimum quantity order. 

Percent Offset The percent offset for relative orders. 

Electronic 
Trade Only 

0 = false 

1 = true 

Firm Quote 
Only 

0 = false 

1 = true 

NBBO Price 
Cap 

Maximum SMART order distance from the NBBO. 

Auction 
Strategy 

For BOX exchange only. 

match = 1 

improvement = 2 

transparent = 3 

Starting Price The starting price. For BOX orders only. 

Stock Ref Price Used for VOL orders to compute the limit price sent to an exchange 
(whether or not Continuous Update is used), and for price range 
monitoring. Also used for price improvement option orders. 

Delta The stock delta. For BOX orders only. 

Stock Range 
Lower 

The lower value for the acceptable underlying stock price range. For price 
improvement option orders on BOX and VOL orders with dynamic 
management. 

Stock Range 
Upper 

The upper value for the acceptable underlying stock price range. For price 
improvement option orders on BOX and VOL orders with dynamic 
management. 

Volatility The option price in volatility, as calculated by TWS ' Option Analytics. This 
value is expressed as a percent and is used to calculate the limit price 
sent to the exchange. 

Volatility Type 1 = daily 

2 = annual 

Reference Price 
Type 

1 = average 

2 = BidOrAsk 

Hedge Delta 
Order Type 

Prior to TWS  Release 859, use "1" to send a market order, "0" for no 
order. After TWS 859, enter an accepted order type such as: MKT, LMT, 
REL. 

Continuous 
Update 

0 = false 

1 = true 

Hedge Delta Enter the Aux Price for Hedge Delta order types that require one. 
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Attribute Valid Values 

Aux Price 

Trail Stop Price Used for Trailing Stop Limit orders only. This is the stop trigger price for 
TRAILLMT orders. 

Scale Num 
Components 

Used for Scale orders only, this value defines the number of components 
in the order. 

Scale 
Component 
Size 

Used for Scale orders only, this value defines the order size of the each 
order component. 

Scale Price 
Increment 

Used for Scale orders only, this value is used to calculate the per-unit 
price of each component in the order. This cannot be a negative number. 

Outside RTH 0 = false 

1 = true 
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Appendix B – Account Page Values 
Values in the Account page are described in the table below. Note that your 
spreadsheet might show the same field name on multiple rows, maybe with 
something like this: Available Funds, Available Funds - S and AvailableFunds - 
C. The above example would be showing the total Available Funds, the Available 
Funds for securities, and the Available Funds for commodities. 

Field Description Notes 

Account Code The account number.  

Account Ready ??  

Account Type Identifies the IB account type.  

Accrued Cash Reflects the current month's accrued debit 
and credit interest to date, updated daily. 

At the beginning of each 
month, the past month’s 
accrual is added to the 
cash balance and this 
field is zeroed out. 

Available Funds For securities:  
Equity with Loan Value - Initial margin 

For commodities:  
Net Liquidation Value - Initial margin 

 

Buying Power Cash Account :  
(Minimum (Equity with Loan Value, 
Previous Day Equity with Loan Value)-
Initial Margin)  

Standard Margin Account :  
Available Funds*4 

 

Cash Balance For securities: 
Settled cash + sales at the time of trade 

For commodities:  
Settled cash + sales at the time of trade + 
futures PNL 

 

Currency Shows the currency types that are listed in 
the Market Value area. 

 

Cushion Shows your current margin cushion.  

Day Trades 
Remaining 

Number of day trades left for pattern day 
trader period. 

 

 

Day Trades 
Remaining T+1, 
T+2, T+3, T+4 

The number of day trades you have left for 
a 4-day pattern day-trader. 

 

Equity With 
Loan Value 

For Securities: 

 Cash Account : Settled Cash 

Margin Account :  
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Field Description Notes 

Total cash value + stock value + bond 
value + (non-U.S. & Canada securities 
options value) 

For Commodities: 

Cash Account : Total cash value + 
commodities option value - futures 
maintenance margin requirement + 
minimum (0, futures PNL) 

Margin Account : Total cash value + 
commodities option value - futures 
maintenance margin requirement 

Excess Liquidity Equity with Loan Value - Maintenance 
margin  

 

Exchange Rate The exchange rate of the currency to your 
base currency. 

 

Full Available 
Funds 

For securities:  
Equity with Loan Value - Initial margin 

For commodities:  
Net Liquidation Value - Initial margin 

 

Full Excess 
Liquidity 

Equity with Loan Value - Maintenance 
margin 

 

Full Init Margin 
Req 

Overnight initial margin requirement in the 
base currency of the account. 

 

Full Maint 
Margin Req 

Maintenance margin requirement as of 
next period's margin change in the base 
currency of the account. 

 

Future Option 
Value 

Real-time mark-to-market value of futures 
options. 

 

Futures PNL Real-time change in futures value since 
last settlement. 

 

Gross Position 
Value 

Long Stock Value + Short Stock Value + 
Long Option Value + Short Option Value. 

 

Init Margin Req Initial margin requirement in the base 
currency of the account. 

 

Leverage For Securities: 

Gross Position value / Net Liquidation 
value 

For Commodities: 

Net Liquidation value - Initial margin 

 

Look Ahead 
Available Funds 

For Securities: 

Equity with loan value - look ahead initial 
margin. 

For Commodities: 
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Field Description Notes 

Net Liquidation value - look ahead initial 
margin. 

Look Ahead 
Excess Liquidity 

Equity with loan value - look ahead 
maintenance margin. 

 

Look Ahead Init 
Margin Req 

Initial margin requirement as of next 
period's margin change in the base 
currency of the account. 

 

Look Ahead 
Maint Margin 
Req 

Maintenance margin requirement as of 
next period's margin change in the base 
currency of the account. 

 

Maint Margin 
Req 

Maintenance margin requirement in the 
base currency of the account. 

 

 

Net Liquidation For Securities: 

Total cash value + stock value + securities 
options value + bond value 

For Commodities: 

Total cash value + commodities options 
value 

 

Net Liquidation 
by Currency 

Same as above for individual currencies.  

Option Market 
Value 

Real-time mark-to-market value of 
securities options. 

 

PNL The difference between the current market 
value of your open positions and the 
average cost, or Value - Average Cost. 

 

Previous Day 
Equity with Loan 
Value 

Marginable Equity with Loan Value as of 
16:00 ET the previous day, only applicable 
to securities. 

 

Realized PnL Shows your profit on closed positions, 
which is the difference between your entry 
execution cost and exit execution cost, or 
(execution price + commissions to open 
the positions) - (execution price + 
commissions to close the position). 

 

Reg T Equity Initial margin requirements calculated 
under US Regulation T rules. 

 

Reg T Margin For Securities: 

Cash Account : Settled Cash 

Margin Account : Total cash value + stock 
value + bond value + (non-U.S. & Canada 
securities options value) 

For Commodities: 

Cash Account : Total cash value + 
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Field Description Notes 

commodities option value - futures 
maintenance margin requirement + 
minimum (0, futures PNL) 

Margin Account : Total cash value - futures 
maintenance margin requirement 

SMA Max ((EWL - US initial margin 
requirements)*, (Prior Day SMA +/- 
change in day's cash +/- US initial margin 
requirements** for trades made during 
the day.)) 

*calculated end of day under US Stock 
rules, regardless of country of trading.  

**at the time of the trade 

Only applicable for 
securities. 

Stock Market 
Value 

Real-time mark-to-market value of stock  

Total Cash 
Balance 

Cash recognized at the time of trade + 
futures PNL 

 

Total Cash 
Value 

Total cash value of stock, commodities and 
securities 
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Appendix C – Allocation Methods and Profiles 
Allocation Methods for Account  Groups 

Note that you must type the method name in exactly as appears here, or your 
order won’t work. 

EqualQuantity Method  

Requires you to specify an order size. This method distributes shares equally 
between all accounts in the group.  

Example: You transmit an order for 400 shares of stock ABC. If your Account  
Group includes four accounts, each account receives 100 shares. If your Account 
Group includes six accounts, each account receives 66 shares, and then 1 share is 
allocated to each account until all are distributed. 

NetLiq Method 

Requires you to specify an order size. This method distributes shares based on the 
net liquidation value of each account. The system calculates ratios based on the 
Net Liquidation value in each account and allocates shares based on these ratios. 

Example: You transmit an order for 700 shares of stock XYZ. The account group 
includes three accounts, A, B and C with Net Liquidation values of $25,000, 
$50,000 and $100,000 respectively. The system calculates a ratio of 1:2:4 and 
allocates 100 shares to Client A, 200 shares to Client B, and 400 shares to Client 
C. 

AvailableEquity Method 

Requires you to specify an order size. This method distributes shares based on the 
amount of equity with loan value currently available in each account. The system 
calculates ratios based on the Equity with Loan value in each account and 
allocates shares based on these ratios. 

Example: You transmit an order for 700 shares of stock XYZ. The account group 
includes three accounts, A, B and C with available equity in the amounts of 
$25,000, $50,000 and $100,000 respectively. The system calculates a ratio of 
1:2:4 and allocates 100 shares to Client A, 200 shares to Client B, and 400 shares 
to Client C. 

PctChange Method  

This method only works when you already hold a position in the selected 
instrument. Do not specify an order size. Since the quantity is calculated by the 
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system, the order size is displayed in the Quantity field after the order is 
acknowledged. This method increases or decreases an already existing position. 
Positive percents will increase a position, negative percents will decrease a 
position. 

Example 1: Assume that three of the six accounts in this group hold long positions 
in stock XYZ. Client A has 100 shares, Client B has 400 shares, and Client C has 
200 shares. You want to increase their holdings by 50%, so you enter "50" in the 
percentage field. The system calculates that your order size needs to be equal to 
350 shares. It then allocates 50 shares to Client A, 200 shares to Client B, and 100 
shares to Client C.  

Example 2: You want to close out all long positions for three of the five accounts 
in a group. You create a sell order and enter "-100" in the Percentage field. The 
system calculates 100% of each position for every account in the group that holds 
a position, and sells all shares to close the positions. 

These handy charts make it easy to see how negative and positive percent values 
will affect long and short positions for both buy and sell orders. Phew, that was a 
mouthful! 

BUY 
ORDER  

Positive 
Percent 

Negative 
Percent  

Long 
Position 

Increases 
position 

No effect 

Short 
Position  

No effect Decreases 
position 

 

SELL 
ORDER  

Positive 
Percent 

Negative 
Percent  

Long 
Position 

No effect Decreases 
position 

Short 
Position  

Increases 
position 

No effect 
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Allocation Profiles 

Percentages  

This method will split the total number of shares in the order between listed 
accounts based on the percentages you indicate.  

Example: An order for 1000 shares using a profile with four accounts at 25% each 
would allocate 250 shares to each listed account in the profile. 

Ratios 

This method calculates the allocation of shares to the listed accounts based on the 
ratios you indicate.  

Example: An order for 1000 shares using a profile with four accounts set to a ratio 
of 4, 2, 1, 1 would allocate 500, 250, 125 and 125 shares to the listed accounts, 
respectively. 

Shares  

This method allocates an absolute number of shares to each account listed. If you 
use this method, you don’t need to enter an order quantity. The order size is 
determined by adding together the number of shares allocated to each account in 
the profile. 
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